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Introduction 
Paragon Drive Copy™ 10.0 is a comprehensive tool of disk copying, upgrading and configuring 
needs. With the next generation of Paragon Adaptive Restore™ as well as support for the system 
virtualization, the product can also be used for migration of a Win2K+ physical system either to a 
different hardware platform (P2P) or a virtual environment (P2V). Moreover including the basic 
backup and restore facilities it can help you protect your system and data against a hardware 
failure, a virus attack, or a human mistake. 

Most functionality of the product is offered through handy intuitive wizards, that’s why not only IT 
pros, but also inexperienced users can find it easy and efficient. 

In this manual you will find the answers to many of the technical questions, which might arise while 
using the program. 

 

Our company is constantly releasing new versions and updates to its software, 
that's why images shown in this manual may be different from what you see on 
your screen. 

What’s New in Drive Copy 10.0 
• P2V Copy to migrate a Win2K+ physical system to a virtual environment in the online mode. 

• Support for major virtualization software vendors including MS Virtual PC, MS Virtual Server, MS 
Hyper-V, VMware Workstation, VMware Fusion, and VMware ESX Server. 

• Next generation Adaptive Restore (P2P Adjust OS) to successfully migrate a Win2K+ physical 
system to a different hardware platform (P2P) by allowing automatic injection of all required 
drivers and the other actions crucial for a migration of this kind. 

• Smart Driver Injector to make the process of adding new drivers for P2V and P2P operations 
smooth and easy. 

• Support for the latest operating systems from Microsoft (Windows 7 and Windows Server 2008 
R2). 

• The latest Linux kernel to enjoy support of a wider range of hardware configurations, including 
the brand new Intel ICH9 chipset. 

• WinPE 2.1 based bootable recovery environment to enjoy support of a wider range of 
hardware configurations with the option to add drivers for specific hardware on-the-fly. 

• More flexibility for online data processing techniques to provide for easier configuration for 
both, Paragon Hot Processing and Microsoft Volume Shadow Copy Service (VSS). 

• Better support for 64-bit platforms to reboot your computer to one of the three special modes 
(Windows native, Linux, or DOS) to automatically complete operations, which cannot be 
accomplished under 64-bit Windows. 
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• Automatic data exclusion with an advanced system of filters will help you automate the 
process of building up contents of the future backup image, by excluding irrelevant data such 
as movies, music, etc. 

• Better support for GUID Partition Table (GPT) to back up and restore not only single GPT 
volumes but entire disks, including the option of resize during the restore operation. 

• Better support for the Apple Boot Camp Configuration with the option not only back up and 
restore this kind of configurations, but to copy single volumes or entire disks with resize. 

• Better support for Linux ExtFS starting from Ext2FS up to the brand new Ext4FS. 

Product Components 
In order to cope with different tasks, the product contains several components: 

• Windows based set of utilities is the crucial part of the product. With the help of an easy to use 
launcher you may find and run tasks of any complexity in the field of data and system 
protection, hard disk partitioning and cloning, etc. 

• Linux/DOS based Recovery CD is a multi-platform bootable media that enables to run utilities 
under Linux or PTS DOS, and that way to get access to your hard disk for maintenance or 
recovery purposes. Both platforms have their strong sides, for instance Linux can boast support 
of FireWire (i.e. IEEE1394) or USB devices. It enables to burn CD/DVD disks. However there can 
be some difficulties with detecting new hardware. DOS in its turn has no problems of that kind 
but is limited in features. The Linux/DOS Recovery CD requires no installation and can be of 
great help when the system fails to boot. Besides it offers a Windows XP like environment. 

• WinPE based Recovery CD. Especially for keen followers of Windows, our product also offers a 
WinPE 2.1 based bootable media. Unlike Linux/DOS Recovery CD it can boast an excellent 
hardware support and the same interface as for the Windows version. However its system 
requirements are much tougher. 

Features Overview 
This chapter dwells upon key benefits and technical highlights of the product. 

Key Features  
Let us list some of the key features: 

User Friendly Fault Minimizing Interface 
• Graphical representation of the data to gain a better understanding. 

• A handy launcher to easily find and run the required tasks. 

• Comprehensive wizards to simplify even the most complex operations. 

• A context sensitive hint system for all functions of the program.  
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• Previewing the resulting layout of hard disks before actually executing operations (so-called 
virtual operations). 

Backup Facilities 
• Support of basic techniques to store backup images: 

- Backup to local mounted partitions; 

- Backup to a network drive to stand a better chance of success in case of a hard disk failure. 

• Sector backup to save not only all on-disk information but also the system service structures. It 
is ideal for making a backup image of an entire hard disk or system partitions to guarantee the 
operating system’s working capability. 

Restore Facilities 
• Restore an entire disk, separate partitions or only files you need from the previously created 

backup image. 

• Restore with Shrink to restore a backup image to a free block of smaller size taking into 
account only the amount of actual data of the image. 

• Adaptive Restore to successfully migrate a Win2K+ physical system to a different hardware 
platform (P2P) by allowing automatic injection of all required drivers and the other actions 
crucial for a migration of this kind. 

Virtualization Facilities 
• P2V Copy to migrate a Win2K+ physical system to a virtual environment in the online mode. 

 
Virtualization is the latest trend in system migration, protection, and evaluation. 

Copy Facilities 
• One Button Copy Wizard to carry out such a technically complicated operation as cloning of 

hard disks just by pressing one button. 

• Partition/hard disk copy to successfully transfer all on-disk information including standard 
bootstrap code and other system service structures, thus maintaining the operating system’s 
working capability. 

 
Copy functionality can also be used as an alternative way of data protection. 

Partition/Hard Disk Management Facilities 
• Basic functions for initializing, partitioning and formatting hard disks (create, format, delete). 

Instead of the standard Windows disk tools, the program supports all popular file systems. 

• Mount a partition (assign a drive letter) of any file system type to make it available for your 
operating system. 
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• Modify file system parameters (make active/inactive, hide/unhide, change serial number, 
partition ID, volume label, etc.). 

• Undelete Partitions Wizard to recover an accidentally deleted partition. 

Automatization Facilities 
• Task scheduling to automate routine operations. It can be particularly effective when you 

have to repeat a sequence of actions on a regular basis. 

 
Scheduling is only available for the Windows installation of the program. 

Auxiliary Facilities 
• File Transfer Wizard to make such operations as transferring of files/directories or burning of 

them to CD/DVD as easy and convenient as possible. Providing access to Paragon backups 
as regular folders, it may also help to replace corrupted data from a previously created 
image in case of an operating system failure. 

• Recovery Media Builder to create a Linux/DOS bootable media, which can later be used to 
boot and recover your computer in case of an operating system failure. Moreover, with its 
help you can save data from partitions of your hard disk directly to compact discs or burn ISO-
images. The utility supports various formats of laser discs: CD-R/RW, DVD-R/RW, DVD+R/RW, 
DVD-R, DVD+R double layer, Blu-ray and can handle multi-session burning. 

• Network Configuration Wizard to establish a network connection under Linux or WinPE either to 
save a backup of a partition/hard disk or just several files on a network computer or retrieve a 
previously made backup from a network computer for recovery purposes. 

• Boot Corrector to fix most of the system boot problems that can be a result of a human factor, 
program error or a boot virus activity. 

 
It’s only available for the Linux/DOS bootable recovery environment. 

Supported Technologies 
Along with using innovative technologies from outside, Paragon has developed a number of its own 
original technologies that make its products unique and attractive for customers: 

• Paragon Hot Backup™ technology to back up locked partitions and hard disks under 
Windows NT+ family operating systems providing both high operating efficiency as well as low 
hardware requirements. 

• Paragon Adaptive Restore™ technology to successfully migrate a Win2K+ physical system to a 
different hardware platform (P2P). 

• Paragon Power Shield™ technology to provide data consistency in case of a hardware 
malfunction, power outages or an operating system failure. 
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• Paragon UFSD™ technology to browse partitions of any file system including hidden and 
unmounted, modify and copy files and folders, etc. 

• Paragon Restore with Shrink™ technology to restore a backup image to a free block of smaller 
size taking into account only the amount of actual data of the image. 

• Paragon Smart Partition™ technology to securely perform hard disk partitioning operations of 
any complexity. 

• Paragon BTE™ technology to set tasks for execution in the Windows blue screen mode, thus 
saving from the need to use a bootable media when modifying system partitions. 

• Paragon VIM™ (Virtual Image Management) technology that enables Paragon products work 
with virtual disks as though they are physical hard disks. 

• Microsoft Volume Shadow Copy Service (VSS) to provide the copy/backup infrastructure for 
the Microsoft Windows XP/Vista/7/Server 2003/2008 operating systems. It offers a reliable 
mechanism to create consistent point-in-time copies of data known as shadow copies. 
Developed by Microsoft in close cooperation with the leading copy/backup solution vendors 
on the market, it is based on a snapshot technology concept. 

• Microsoft Dynamic Disk (simple, spanned, striped, mirrored, RAID-5) to offer more 
management flexibility without the partition limitation of basic disks. Dynamic storage can be 
particularly beneficial for large-scale businesses when dealing with many physical hard disks 
involving complex setup. 

• GUID Partition Table (GPT). It is the next generation of a hard disk partitioning scheme 
developed to lift restrictions of the old MBR. GPT disks are now supported by Windows Vista/7, 
Server 2008, Mac OS X and Linux. 

Supported File Systems 
Paragon Drive Copy 10.0 provides support of major file systems presented on the market today: 

• Full read/write access to FAT16/FAT32 partitions. 

• Full read/write access to NTFS (Basic and all five types of Dynamic Disks) under Windows 
95/98/ME, Linux and PTS DOS. Compressed NTFS files are also supported. 

• Full read/write access to Ext2FS/Ext3FS/Ext4FS partitions under all versions of Windows, DOS 5.0 
and later. 

• Limited read/write access to Apple HFS+ partitions. 

 

Unfortunately, support of non-Roman characters for the HFS+ file system is 
unavailable at the moment. The company is about to implement it in the 
nearest future. 

Supported Media 
• Support of both MBR and GPT hard disks (up to 1,5 TB tested) 
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• IDE, SCSI and SATA hard disks 

• CD-R, CD-RW, DVD-R, DVD+R, DVD-RW, DVD+RW, DVD-R, DVD+R double layer and also Blu-ray 
discs 

• FireWire (i.e. IEEE1394), USB 1.0, USB 2.0 hard disks 

• PC card storage devices (MBR and GPT flash memory, etc.) 

Getting Started 
In this chapter you will find all the information necessary to get the product ready to use. 

Distribution 
Paragon Drive Copy 10.0 is distributed in two ways: 

• Boxed package from Paragon Technology GmbH and resellers 

• Downloadable package over the Internet at the company’s web-site 

Distributive CD 
The boxed package includes a distributive CD that is in fact a bootable Linux/DOS Recovery CD with 
auto-run of the Windows installation, thus it can be used as a ready-made solution (see Booting from 
the Linux/DOS Recovery CD). But if you’re going to run the Windows components, you need to install 
them first (see Installing the Program under Windows). 

If you want to download an update/upgrade of the product, it will be in form of the downloadable 
installation package as described in Online Distribution). 

 
The WinPE version can only be obtained through the company’s web service. 
You will get the required download link after the product has been purchased. 

Online Distribution 
Drive Copy 10.0 purchased over the Internet will be in form of an MSI package. After installing the 
product you can launch the Recovery Media Builder to burn the Linux/DOS Recovery CD. 

 
The WinPE version can only be obtained through the company’s web service. 
You will get the required download link after the product has been purchased. 

Registration 
Paragon Technology GmbH provides a wide range of online services through its web-portal - 
www.paragon-software.com/support/: 

• Registration of new users; 

• Registration of purchased products for registered users; 

• Available around-the-clock downloading center, where registered users can get product 
updates/upgrades as well as all the necessary documentation; 

http://www.paragon-software.com/support/
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• Downloadable free demo versions and open documentation for all users. 

 
It is recommended to use Internet Explorer 5+ or any compatible browser. 

To register as a new user 
To register as a new user, please do the following: 

1. Run an Internet browser and visit the page: www.paragon-software.com/my-account/; 

2. Click Create of the Create a Paragon Account section; 

3. Fill out a registration form; 

4. Click Register. 

The most important field in the form is an E-mail address, as it serves as a login to enter the system. 
Besides your access password will be sent to this address as well. 

To register a new product 
If you are a registered user and would like to register Partition Manager 10, please do the following: 

1. Run an Internet browser and visit the page: www.paragon-software.com/my-account/; 

2. In the Email field of the Authorization section, enter an E-mail used for registration; 

3. In the Password field enter a password received after registration; 

4. Click Sign in; 

5. If the user name and password are valid, you will get to your account; 

6. Click Register new product of the Products section; 

7. Enter your product serial number in the Serial Number field. You can find it in the product box 
or obtain from your reseller. Click Next; 

8. On the next page you will be asked to provide some additional data. Also you will need to 
decide whether you want to get confirmation on registering the product by E-mail or not. 
Click Next, and then click Finish. 

That is all. The product is now registered. 

How to Download Updates/Upgrades 
Downloading of updates/upgrades can be fulfilled in the following way: 

1. Run an Internet browser and visit the page: www.paragon-software.com/my-account/; 

2. In the Email field of the Authorization section, enter an E-mail used for registration; 

3. In the Password field enter a password received after registration; 

4. Click Sign in; 

https://www.paragon-software.com/my-account/login.htm
https://www.paragon-software.com/my-account/login.htm
https://www.paragon-software.com/my-account/login.htm
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5. If the user name and password are valid, you will get to your account; 

6. Select My Downloads of the Products section to see what updates are available for you; 

7. Select the desired update and click Download. 

Contacting Paragon Technology GmbH 
If you have any questions about the company products, please do not hesitate to contact Paragon 
Technology GmbH. 

Service Contact 

Visit Paragon GmbH web site www.paragon-
software.com

Registration & updates web-
service 

www.paragon-
software.com/support

Knowledge Base & Technical 
Support kb.paragon-software.com

Pre-sale information sales@paragon-
software.com

System Requirements 

Windows based set of utilities 
To use the Windows utilities, you should install them first. But before that, make sure your computer 
meets the following minimum system requirements: 

• Operating systems: Windows 2000/XP/Vista/7/Server 2000/2003/2008 and XP SP2/Vista/7/Server 
2003/2008 64-bit 

• Internet Explorer 5.0 or higher  

• Intel Pentium CPU or its equivalent, with 300 MHz processor clock speed  

• 128 MB of RAM (256+ recommended) 

• Hard disk drive with 100 MB of available space  

• SVGA video adapter and monitor  

• Mouse 

Linux/DOS based Recovery CD 
To use the Paragon Linux/DOS Recovery CD on your computer (it doesn’t matter what operating 
system is installed), make sure that it meets the following minimum system requirements: 

• IBM AT compatible computer with i486 or higher CPU 

• 256 MB of RAM  

www.paragon-software.com
www.paragon-software.com
https://www.paragon-software.com/support/index.html
https://www.paragon-software.com/support/index.html
http://kb.paragon-software.com/
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• SVGA-compatible monitor 

• Mouse (recommended) 

• On-board BIOS supports booting from CD first 

WinPE based Recovery CD 
To use the WinPE based Recovery CD on your computer, (it doesn’t matter what operating system is 
installed), make sure that it meets the following minimum system requirements: 

• Intel Pentium III CPU or its equivalent, with  1000 MHz processor clock speed  

• At least 512 MB of RAM 

• SVGA video adapter and monitor 

• Mouse 

Additional Requirements 
There may be additional requirements if you want to use advanced features: 

• Network card is required to send partition/hard disk backups to a network computer or to 
retrieve previously made backups 

• Recordable CD/DVD drive is needed to burn data to compact disks 

• To save copy or backup of a hard disk or partition, removable USB disks can be used. The 
program supports USB Drives 1.0, 2.0.  

Installing the Program under Windows 
As we have already mentioned only Windows components of the product require installation. So to 
install Paragon Drive Copy 10.0 under Windows, please do the following: 

1. Run Setup Application. Click on the *.MSI file. This application will guide you through the 
process of the program installation. The setup utility is compiled with the InstallShield SDK, 
hence it contains the standard user interface and set of installation steps. 

 
In case there is some previous version of the program installed on the 
computer, the program will offer the user to uninstall it first. 

2. Starting Setup. The Welcome page informs that the application is being installed. Click the 
Next button to continue. 

3. Confirm License Agreement. The License Agreement page displays the Paragon License 
Agreement. Read the agreement and then select the appropriate option to accept. If you do 
not agree with any conditions stated there, the installation process will be interrupted. By 
clicking the Print button, the License Agreement may also be printed out. 

4. Provide Registration Information. On the Registration page you are to provide your product 
key and serial number. 
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5. Provide Customer Information. On the Customer Information page you are to provide the 
standard information, i.e. a user name and an organization. Besides you need to decide 
whether to make the program available for all users of this computer (if several) or only for the 
current one. 

6. Select an Installation Folder. The Destination Folder page allows you to choose a folder where 
the program will be installed. By default, the installation folder will be created as: 

C:\Program Files\Paragon Software\Paragon Drive Copy 10.0. To select another folder, click 
the Change… button. 

After you have selected the required folder, click the Next button to continue. 

 

Do not install the program on network drives. Do not use Terminal Server 
sessions to install and run the program. In both cases, the program 
functionality will be limited. 

7. Confirm Installation. On the Ready to Install the Program page click the Install button to start 
the installation or the Back button to return to any of the previous pages and modify the 
installation settings. 

8. Copying Files. The Copying Files page shows the overall progress of the installation. Click the 
Cancel button to abort the setup. 

9. Finishing the Installation. The Final page reports the end of the setup process. Click the Finish 
button to complete the wizard. 

 

To accomplish online backup/copy of locked partitions/hard disks the 
program uses a kernel mode hotcore driver, thus the system reboot is required 
to complete the installation procedure. 

Starting the Program under Windows 
To start Paragon Drive Copy 10.0 under Windows, please click the Windows Start button and then 
select Programs > Paragon Drive Copy™ 10.0 > Paragon Drive Copy™. 

 

The program provides wide opportunities in the field of hard disk structure 
modification, so just to be on the safe side, please make a backup of your 
data before carrying out any operation. 

The first component that will be displayed is called the Express Launcher. Thanks to a well thought-out 
categorization and hint system, it provides quick and easy access to wizards and utilities that we 
consider worth using on a regular basis. With its help you can also start up the traditional launcher, 
the help system or go to the program’s home page. 
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To start up the traditional launcher, please click the Advanced Mode option 
found at the bottom of the window. To know more on the subject, please 
consult the Windows Components chapter. 

Booting from the Linux/DOS Recovery CD 
The Linux/DOS Recovery CD can be used to boot your computer into Linux or PTS DOS to get access 
to your hard disk for maintenance or recovery purposes. On the disk you can also find the PTS DOS 
safe mode, which may help in a number of non-standard situations such as interfering hardware 
settings or serious problems on the hardware level. In this case, only basic files and drivers (such as 
hard disk drivers, a monitor driver, and a keyboard driver) will be loaded. 

Startup Procedure 
To start working with the Linux/DOS Recovery CD, please take the following steps:  

1. Insert the Linux/DOS Recovery CD into a CD/DVD drive. 

2. Reboot the computer. 

3. Launch a boot mode you need (Normal, Safe, Low-Graphics Safe) in the Boot menu. 

 
By default the Normal Mode will be automatically initiated after a 10 second 
idle period. 

4. Click on the required operation to start. Hints on the selected at the moment item will help you 
make the right choice. 
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5. Consult the help system by pressing ALT+F1 to know more on the subject. 

 
To automatically boot from the Recovery CD make sure the on-board BIOS is 
set up to boot from CD first. 

Boot Menu 
After you have inserted the Recovery CD into a CD/DVD drive and restarted the computer, the Boot 
menu appears. 

 

The Boot menu contains the following commands: 

• Normal Mode. Boot into the Linux normal mode. This mode uses the full set of drivers 
(recommended); 

• Safe Mode. Boot into the PTS DOS mode. This mode can be used as an alternative of the Linux 
normal mode if it fails to work properly; 

• Low-Graphics Safe Mode. Boot into the PTS DOS safe mode. In this case, only the minimal set 
of drivers will be included, like hard disk, monitor, and keyboard drivers. This mode has simple 
graphics and a simple menu; 

• Floppy Disk. Reboot the computer from a system floppy disk; 

• Hard Disk 0. Boot from the primary hard disk; 

• Find OS(s) on your hard disks. The program will scan hard disks of your computer to find any 
bootable operating system. 

To move within the menu, please use the arrow keys of the computer keyboard. 

 

To automatically boot from the Recovery CD make sure the on-board BIOS is 
set up to boot from CD first. 

While working with the Recovery CD you might experience some 
inconvenience caused by possible video artifacts. It is just a result of changing 
video modes and in no way will affect the program functionality. If this is the 
case, please wait a bit and everything will be OK. 

Normal Mode 
When the Normal mode is selected, the Linux launch menu appears: 
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• Drive Copy (enables to copy and back up separate partitions or entire hard disks, carry out 
basic partitioning operations, etc.); 

• Simple Restore Wizard (allows restoring hard disks and partitions); 

• Disk Copy Wizard (helps to clone a hard disk); 

• File Transfer Wizard (allows coping files/folders to another disk or a partition as well as 
recording them to CD/DVD); 

• Boot Corrector (helps to correct the Windows System Registry without Windows being loaded); 

• Network Configurator (enables to establish a network connection under Linux); 

 
If you are going to use network resources, first launch the Network 
Configuration Wizard to establish a network connection. 

• Log Saver (helps to collect and send the necessary log files to the Technical Support); 

• Eject CD/DVD; 

• View the mounted partitions (the list of all mounted partitions will be displayed); 

 

Linux/DOS Recovery CD assigns drive letters to partitions the way it is done in 
DOS, i.e. one after another, primary partitions at first. Thus mounted partitions 
may have different drive letters from Windows. 

• Command Line (allows experienced users to execute any operation); 

• Reboot the computer; 

• Power off the computer. 

To move within the menu, please use the arrow keys of the computer keyboard. 
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Safe Mode 
When the Safe mode is selected, the PTS DOS launch menu appears. It has nearly the same 
functionality as for the Normal mode except the Network Configurator and Log Saver commands. 
Besides due to certain limitations of the PTS DOS environment, there is no possibility to burn CD/DVD 
disks. 

Low Graphics Safe Mode 
When the Low Graphics mode is selected, the PTS DOS launch menu appears. It has the same 
functionality and looks similar to the Safe mode but graphically simpler. 

 

Booting from the WinPE Recovery CD 
The WinPE Recovery CD can be a real alternative to the Linux/DOS Recovery CD. Providing nearly 
the same level of functionality it offers an excellent hardware support and the same interface as for 
the Windows version. 

Startup Procedure 
To start working with the WinPE Recovery CD, please take the following steps: 

1. Insert the WinPE Recovery CD into a CD/DVD drive. 

2. Reboot the computer. 

3. After the disc has been loaded, you will see the License Agreement. Read the agreement 
and then mark the appropriate checkbox to accept. If you do not agree with any conditions 
stated there, you won’t be able to use the program. 
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�  
To automatically boot from the Recovery CD make sure the on-board BIOS is 
set up to boot from CD first. 

4. Once you accept the agreement, you will see the Universal Application Launcher. In general 
it enables to run components of the product, load drivers for undefined hardware or establish 
a network connection. 

 

5. Click on the required operation to start. Hints on the selected at the moment item will help you 
make the right choice. 
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6. Consult the help system by pressing ALT+F1 to know more on the subject. 

Basic Concepts  
This chapter explains terms and ideas that show how the program works. To understand these helps 
to obtain a general notion of the operation performance and makes it easier for the user to operate 
the program. 

System and Data Protection  
The data protection issue is a growing cause of worrying for more and more people today. Indeed, it 
is hardly to find a person who will be particularly happy when all precious information on the hard 
disk is irreversible lost as a result of its malfunction. So how this tragedy can be prevented? 

File Backup versus Sector Backup 
Since the advent of the computer age people were in the search of ways to guarantee data safety. 
As a result we’ve got now two principal approaches: the file-based backup and the sector-based 
backup. The main difference between the two lies in the way data is treated. 

A sector-based backup operates with an image (or a snapshot) of the whole disk system or its 
separate partitions. It not only includes the contents of all user-made files, but additionally contains 
the exact structure of directories, information about file allocation, file attributes and other related 
data. Thus it enables to successfully process system or encrypted partitions of any file system type, no 
matter what kind of information they contain. 

In contrast, a file-based backup takes into account a file system structure and only functions on a file 
or folder level. So it is very efficient when archiving separate files or folders, but in no way will help you 
back up a system partition. 

You should understand pretty well that each of the two approaches is only good when properly 
chosen. In the comparison table below you can see when this or that approach will suit you at most. 

Sector-Based Backup File-Based Backup 

Merits 

It does not dependent on a particular file 
system. Thus it can successfully process 
system or encrypted partitions of any file 
system type, no matter what kind of 
information they contain. 

Functioning on a file/folder level, it is ideal 
for archiving separate files or folders. 

It can create an exact image of a 
partition, including its service data. Thus it 
is ideal for a backup/restore of a system 
partition or a fast deployment to a bunch 
of identical computers. 

It enables to automatically build up 
contents of the future backup image by 
using an advanced system of filters. 

 It allows archiving data of the same 
volume with different backup policies. 
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 It is easy and efficient when creating 
backup chains. 

Demerits 

Resulted backup images may contain a 
lot of redundant data. 

It depends on a file system structure, so 
you won’t be able to process unknown 
file systems. 

It is ineffective when trying to maintain a 
backup chain, especially when little 
amount of data is being changed. 

It cannot be used to back up a system 
partition. 

 It is much slower when processing large 
amount of data. 

Backup Storage 
Our program supports basic techniques of storing backup images. Let’s take a closer look at them to 
understand what kind of storage is able to provide better security: 

• You can place a backup image to a local mounted partition. Despite the fact that it is the 
most convenient way, try not to use it. You can delete your backup just by accident or lose it 
as a result of a hardware malfunction, or a virus attack; 

• You can place a backup image to a network drive to stand a better chance of success in 
case of a hard disk failure. Moreover, by storing it on a special-purpose server you may be 
pretty sure nothing will happen to it. 

Adaptive Restore 
Adaptive Restore is a special technology that enables to successfully recover Windows 
2000/XP/Server 2003 as well as Windows Vista/7/Server 2008 to a different hardware configuration. As 
you probably know, Windows family operating systems are pretty much sensible to any hardware 
replacement, especially when you need to replace your motherboard - actually Windows will most 
likely fail to boot as a result of this operation. 

With our technology (available in the P2P Adjust OS Wizard) you can make your Windows bootable 
on some other computer by allowing automatic injection of all required drivers and the other actions 
crucial for a migration of this kind. Actually, this operation for Windows 2000/XP/Server 2003 and 
Windows Vista/7/Server 2008 differs a bit, so does the wizard’s work algorithm. 

Adaptive Restore for Windows 2000/XP/Server 2003 
It actually implies three operations: 

• Providing the ability to change the Windows kernel settings to the most suitable for your new 
configuration. The program will automatically add all available Windows HAL and kernels to 
the boot menu (the boot.ini file) to choose the required platform in case your system fails to 
boot (Uniprocessor, Multiprocessor, or Old legacy PC without ACPI). You can later remove 
them from the menu either under Windows or with Boot Corrector. 



24 

Copyright© 1994-2010 Paragon Software Group. All rights reserved. 

�  
If you’ve got a 64-bit operating system, no options will be added to the boot 
menu. 

• Automatic replacement of the boot critical drivers (HDD controller, PS/2 and USB mouse and 
keyboard) to the default Windows drivers to provide the maximum level of compatibility. 
Once your Windows starts up, it will initiate reconfiguration of all Plug'n'Play devices, so we do 
recommend you to provide the latest drivers for your motherboard and processor at this step, 
as it can considerably improve the overall performance of your system. 

• The option to inject 3rd party drivers to guarantee your system will start up on the new 
hardware. Actually you’ve got two options, either provide a path to your own driver repository 
(collection of all drivers to your hardware devices located in one folder) for the program 
automatically pick and install only those drivers required for your OS (recommended), or 
manually specify drivers critical for the guaranteed startup of your system on the new 
hardware. 

Adaptive Restore for Windows Vista/7/Server 2008 
It is based on the fact that these operating systems do not delete their distributive driver repositories 
after the setup, but simply make them inactive in the Windows Registry. So thanks to our technology 
these driver repositories can be made available during the restore procedure to let Windows Vista/7 
or 2008 Server automatically find and install any lacking driver with no action from your side required, 
what is very convenient. 

Anyway, not all drivers can be found in the built-in driver repositories, especially when you’ve got to 
do with specific SCSI or Serial ATA controllers. For situations of this kind you’ve got the option to inject 
any 3rd party driver, either by providing a path to your own driver repository (collection of all drivers to 
your hardware devices located in one folder) for the program automatically pick and install only 
those drivers required for your OS (recommended), or manually specifying drivers critical for the 
guaranteed startup of your system on the new hardware. 

Adaptive Restore Application 
Let’s consider a number of situations when the Adaptive Restore feature can help you out:  

• If you need to upgrade to newer hardware while keeping all your programs and settings 
intact; 

• If you need to replace failed hardware and cannot find an exact match for your original 
system specifications. 

Known Issues 
1. After transferring Microsoft Vista and later versions to different hardware, you will need to re-

activate license of the system. It’s normal behavior as these systems keep tracking any 
change of hardware. Re-activation is legally justified in this case, as you transfer your system to 
another PC. 

2. If you’ve installed several operating systems on one partition, we can only add drivers to the 
latest version of OS. Microsoft highly recommends that you install an operating system on a 
separate partition. 
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3. Please note drivers are not cached during selection. That’s why if you select a driver to add to 
the system, but it’s already unavailable during the operation, the program will end the 
operation with an error. 

System Virtualization 
With new powerful x86 computers, system virtualization has become extremely popular. It’s a 
software technology that enables to run several virtual machines on one physical machine, 
providing resources of that single computer are shared across several environments. As a result one 
and the same physical computer can have multiple OSs and applications operating simultaneously, 
thus opening up enormous opportunities for both, business and home users, exactly: 

• Avoid underutilization of up-to-date powerful computers; 

• Increase flexibility of a physical infrastructure; 

• Provide for increased availability of hardware and applications; 

• Cut expenses on hardware and energy; 

• Guarantee smooth and cost saving system migration; 

• Enjoy working with old applications you can’t launch on your current PC; 

• Take advantage of having multiple operating systems on one Windows PC, including Linux, 
Mac OS X, etc.; 

• Forget about hunting for replacement of the failed hardware, and many more… 

Known Issues 
1. You should install integration services (e.g. VMware Tools) on the virtual system yourself. We 

only guarantee its smooth startup. 

2. At the startup, a virtual machine (e.g. VMware Workstation) might notify you that the used 
virtual disks are of old format and require update. You can update your disks, since this 
procedure involves change of a version only, nothing else. This is done on purpose not to lose 
compatibility with the older versions of VMware. 

3. After transferring Microsoft Vista and later versions to a virtual disk, you will need to re-activate 
license of the system. It’s normal behavior as these systems keep tracking any change of 
hardware. Re-activation is legally justified in this case, as you transfer your system to another 
PC. 

4. If you prefer to create a SCSI HDD when converting to a virtual disk of VMware Workstation or 
VMware ESX Server, we pick a driver for the HDD controller just the way VMware does, i.e. 
according to the found OS: 

• Windows 2000/Windows XP – Buslogic; 

• Windows 2003 (all editions including WinXP x64) and later versions – LSI Logic. 
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Thus if you will then connect the created virtual disk to a virtual machine with another type of 
the adapter, the system won’t start up. Please use our P2P Adjust Wizard to install the required 
driver. 

5. If you convert a partition/hard disk with Windows XP to a SCSI virtual disk of VMware 
Workstation or VMware ESX, it’s required to add the VMware SCSI driver from outside, since 
Windows XP doesn’t have it. To do that we try to find an installed version of VMware 
Workstation on your computer to extract the necessary driver. If failed to find, we will ask you 
to provide a path to the VMware Tools ISO image. 

6. We can smoothly convert a hard disk with several operating systems. But according to Issue 4, 
when converting to a SCSI virtual disk of VMware Workstation or VMware ESX Server, for 
different versions of OS, different controller drivers will be installed. VMware however cannot 
emulate different hardware for each operating system of one virtual machine. To tackle this 
issue, please use our P2P Adjust Wizard to install the LSI Logic driver under Windows 
2000/Windows XP, then select the LSI SCSI controller for your virtual machine. 

Paragon Hot Processing & Volume Shadow Copy Service 

Offline versus Online Data Processing 
In the course of time there have been developed various methods of data processing. Despite 
different work concept, all of them can be divided into two principal groups: offline (cold) and 
online (hot) data processing techniques. 

As the name infers, offline data processing can only be accomplished when the data is in consistent 
state (the operating system and all the applications are completely shut down). Actually it is the most 
preferable way of image creation or data cloning, since software can obtain an exclusive right to 
process data that guaranties high level of operating efficiency. However, the offline data processing 
is absolutely out of question when dealing with 24/7 production environments. 

In contrast, online data processing enables to create a consistent snapshot even as the data is 
currently modified. It is particularly useful for systems with high availability requirements, but it won’t 
be accomplished until all active transactions are complete. The point is to provide a coherent state 
of all open files and databases involved in a process, taking into account that applications may still 
keep writing to disks. As a result an online data processing cannot boast high operating speed. 

Our program supports both offline and online methods of data processing. As far as online method is 
concerned it offers its own hot processing algorithm together with the possibility to use snapshot 
technologies provided by the Microsoft VSS framework. 

Paragon Hot Processing Technology 
Paragon Hot Processing is an online copy/backup technology for Windows NT+ family operating 
systems. Developed back in 2001, nowadays it is integrated with all copy/backup solutions offered 
by the company. 

Paragon Hot Processing is not exactly a snapshot technology, though it has much in common with it. 
During an online copy/backup, the program uses the kernel mode driver HOTCORE.SYS to intercept 
and control disk write activity of applications and the operating system. The hotcore driver as an 
integral part of the program is installed during the setup procedure (that’s why the system reboot is 
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required to complete the setup procedure). For the most part the driver is in the idle mode until it is 
activated with the program. While in this mode it bypasses any calls having no effect on the overall 
system performance, but a few kilobytes of the system memory. 

Paragon Hot Processing technology offers copy/backup of locked partitions and hard disks under 
Windows NT+ family operating systems providing both high operating efficiency as well as low 
hardware requirements. 

�  

It is not recommended to use Paragon Hot Processing with active SQL Server, 
Exchange or Oracle databases since the backup image contents may be 
corrupted. 

Volume Shadow Copy Service 
Microsoft Volume Shadow Copy Service (VSS) is designed to provide the copy/backup infrastructure 
for the Microsoft Windows XP/Vista/Server 2003/2008 operating systems. It offers a reliable mechanism 
to create consistent point-in-time copies of data known as shadow copies. Developed by Microsoft 
in close cooperation with the leading copy/backup solution vendors on the market, it is based on a 
snapshot technology concept.  

Initiated by a VSS aware copy/backup utility, VSS creates snapshots for the selected volumes and 
represents them as virtual read-only devices, called volume shadow copies. Once the shadow 
copies are created, the copy/backup utility starts processing the data while applications keep 
writing to original volumes. 

Unlike Paragon Hot Processing the VSS technology provides a unique possibility to make a 
synchronous snapshot of multiple volumes. This very feature can be particularly beneficial when 
backing up active SQL Server 2003, Exchange 2003 or Oracle databases located on multiple 
volumes the way it is recommended by Microsoft to improve the level of database performance and 
reliability, thus providing 100-percent data consistency. 

�  
To use VSS it is necessary to have a mounted 300 MB+ NTFS partition. 

Dynamic Disks 
As you probably know, MS-DOS, Microsoft Windows 95/98/Me/NT/2000/XP/Vista/Server 2003/2008 
support four primary partitions per physical hard disk, one of which can be extended. Certainly there 
is the possibility to create logical drives within the extended partition. Such types of disks are called 
basic. Windows XP Professional, Windows 2000, Windows Vista and Windows Server 2003/2008 follow 
the same strategy: You can have a maximum of four primary partitions, one of which can be an 
extended partition with logical drives. However, these operating systems also introduce a new disk 
configuration type - dynamic disk - which must be understood to effectively configure and manage 
hard disks. 

Dynamic disk is a physical disk that doesn't use partitions or logical drives. Instead, it contains only 
dynamic volumes. Regardless of what format you use for the file system, only Win2K computers can 
access dynamic volumes directly. However, computers that aren't running Win2K can access the 
dynamic volumes remotely when connected to the shared folders over the network. 
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Dynamic disks can co-exist on a system with basic disks. The only limitation is that you cannot mix 
Basic and Dynamic disks on the same hard drive. 

There are five types of dynamic volumes: simple (uses free space from a single disk), spanned 
(created from free disk space that is linked together from multiple disks), striped (a volume the data 
of which is interleaved across two or more physical disks), mirrored (a fault-tolerant volume the data 
of which is duplicated on two physical disks, and RAID-5 volumes (a fault-tolerant volume the data of 
which is striped across an array of three or more disks). 

With dynamic storage, you can perform disk and volume management without the need to restart 
Windows. 

Limitations: 

• Dynamic disks are not supported on portable computers. 

• Dynamic disks are not supported on Windows XP Home Edition-based computers. 

• You cannot create mirrored volumes or RAID-5 volumes on Windows XP Home Edition, 
Windows XP Professional, or Windows XP 64-Bit Edition-based computers. 

Thus, the dynamic disk is a new way of looking at hard disk configuration. Dynamic disks offer you 
more management flexibility without the partition limitation of basic disks. Dynamic disks can contain 
an unlimited number of volumes, but they cannot contain partitions or logical drives. Dynamic 
storage can be particularly beneficial for large-scale businesses when dealing with many physical 
hard disks involving complex setup. 

GPT versus MBR 
GUID Partition Table (GPT) is the next generation of a hard disk partitioning scheme developed to lift 
restrictions of the old MBR. Being a part of the Extensible Firmware Interface (EFI) standard proposed 
by Intel to replace the outdated PC BIOS, it offers a number of crucial benefits: 

• Up to 128 primary partitions for the Windows implementation (only 4 in MBR); 

• The maximum allowed partition size is 18 exabytes (only 2 terabytes in MBR); 

• More reliable thanks to replication and cyclic redundancy check (CRC) protection of the 
partition table; 

• A well defined and fully self-identifying partition format (data critical to the platform operation 
is located in partitions, but not in un-partitioned or hidden sectors as this is the case with MBR). 

Apple Boot Camp 
Boot Camp is a special utility to help you set up a dual boot system (Mac OS X and 32-bit Windows 
XP/Vista) on Intel-based Macs. It enables to securely re-partition your hard disk (resize an existing 
HFS+ partition to create a separate partition for Windows) and then launch the installation process. 
With Boot Camp all the necessary drivers will be at your disposal. Moreover after Windows has been 
installed it will serve as a boot manager to choose what operating system to start up. 
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�  

It is strongly recommended not to modify the hard disk configuration with 
Windows Disk Manager. Otherwise it may lead to unexpected consequences, 
right up to BSOD and inability to boot in Windows XP/Vista. Please use our 
program to correctly update both MBR and GPT. 

64‐bit Support 
The bulk of software today is written for a 32-bit processor. It can meet the requirements of almost 
any end user. However that is not the case when dealing with servers processing large amounts of 
data with complex calculations of very large numbers. That is where 64-bit architecture comes into 
play.  

It can boast improved scalability for business applications that enables to support more customer 
databases and more simultaneous users on each server. Besides a 64-bit kernel can access more 
system resources, such as memory allocation per user. A 64-bit processor can handle over 4 billion 
times more memory addresses than a 32-bit processor. With these resources, even a very large 
database can be cached in memory.  

Although many business applications run without problems on 32-bit systems, others have grown so 
complex that they use up the 4 GB memory limitation of a 32-bit address space. With this large 
amount of data, fewer memory resources are available to meet memory needs. On a 64-bit server, 
most queries are able to perform in the buffers available to the database. 

Some 32-bit applications make the transition to the 64-bit environment seamlessly others do not. For 
instance, system-level utilities and programs that provide direct hardware access are likely to fail. Our 
program offers a full-fledged support of the 64-bit architecture providing fault-tolerant work for such 
system dependent modules as Hot Processing. 

Copy Operations 
Hard drive duplication nowadays is becoming highly popular among PC users. That is due to some 
definite advantages it can offer. First of all, many people clone hard disks just to back up data for 
security reasons. The present day copy utilities enable to successfully transfer all on-disk information 
including standard bootstrap code and other system service structures, thus maintaining the 
operating system’s working capability. In case of a system malfunction, the user can get the system 
back on track in minutes. No additional configuration is required, what is very convenient. 

The second possible application is the upgrade of a hard disk to a new one. The capacity of a 
modern hard drive doubles every two years, thus opening up new possibilities for software 
developers. As a result programs become more complicated and require considerable amount of 
free space. One day the user realizes that there is no more free space left on the hard disk and the 
only way out is to upgrade. Usually that means that besides purchasing a new hard disk, the user is to 
face a large re-installation procedure spanning several days of tedious work. But all of this can be 
avoided just by copying the contents of the old hard disk to a new one proportionally resizing the 
partitions. 

And the last but not least is the copying of hard disks for cloning purposes. It may be of great use 
when setting up similar computers. There is no need for a system administrator to install an operating 
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system from scratch on every one of them. It is enough just to configure one and then clone it to the 
others. 

Drive Partitioning 
As you probably know a hard drive is to be split into one or more partitions, since it cannot hold data 
until it is carved up and space is set aside for an operating system. Until recently most PCs used to 
have just one partition, which filled the entire hard disk and contained an OS. The situation has 
changed however, thanks to new cost-effective high capacity hard drives, thus opening up 
numerous possibilities for PC users, such as editing video, archiving music, backing up CD images, 
etc. Huge increase in space is great, but it poses a number of problems, most important of which are 
effective data organization and speed. 

Large drives are always going to take longer to search than smaller volumes, and an operating 
system is going to have its work cut out both finding and organizing files. It is for this reason that many 
people decide to invest in multiple hard drives, but there is an easy solution – drive partitioning. 
Partitioning lets you divide a single physical drive into a number of logical drives, each of which 
servers as a container with its own drive letter and volume label, thus enabling the operating system 
to process data more efficiently. Besides partitioning makes it possible to organize data so that it is 
easy to find and manage. You can set aside, for instance, 40 GB of a 160 GB hard drive for the OS, 
70 GB for storing video and another 50 GB for your favorite music collections to provide transparent 
data storage. 

It is also worth mentioning to that with a hard drive properly partitioned, such routine operations as 
files de-fragmentation or consistency check will not be that annoying and time-consuming any 
more. 

By detaching the OS from the rest of the data you can tackle one more crucial issue – in case of a 
system malfunction, you can get the system back on track in minutes by recovering it from a backup 
image located on the other partition of the hard drive. 

But that is not all drive partitioning may be used for. If you are willing to play games in Windows while 
browsing the Internet in Linux, 100-percent sure that no virus will attack your PC, drive partitioning is a 
necessity. In order to run several OSs on a single hard drive you are to create a corresponding 
number of partitions to effectively delineate the boundaries of each OS. 

Scheduling  
The automation of operations is particularly effective when you have to repeat a sequence of 
actions on a regular basis. For example, developing a specific project on a day-to-day basis and 
having to make a backup every evening so as not to lose the valuable data, you will really 
appreciate, when this kind of routine operations will be carried out automatically without your 
participation. 

Another aspect of any automation process is that it allows an optimization of your computer’s work-
load. This is especially important when operations require a considerable amount of computer 
resources – processor time, memory and more. A number of tasks, which can decrease the 
performance, can be run during the night or whenever the computer has the least work-load to 
perform. 
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The program has a special tool for scheduling. You can set out a timetable for any operation and it 
will start at a specified time without interrupting your current activity. 

Windows Components 
In the given section you can find all the information necessary to successfully work with the Windows 
version of the product. 

Interface Overview 
This chapter introduces the graphical interface of the program. The design of the interface precludes 
any mistake being made on the part of the user. Most operations are performed through the system 
of wizards. Buttons and menus are accompanied by easy understandable icons. Nevertheless, any 
problems that might occur while managing the program can be tackled by reading this very 
chapter. 

General Layout  
When you start the program, the first component that is displayed is called the Launcher. It enables 
to run wizards and dialogs, to specify program settings, to visualize the operating environment and 
the hard disk configuration. 

The Launcher’s window can be conditionally subdivided into several sections that differ in their 
purpose and functionality: 
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1. Main Menu  

2. Tool Bar  

3. Virtual Operations Bar  

4. Common Tasks Bar  

5. Explorer Bar  

6. Disk Map  

7. Legend Bar

8. Status Bar

A number of panels offer similar functionality with a synchronized layout. The program enables to 
conceal some of them to simplify the interface management. 

All panels are separated by vertical and horizontal expandable sliders, allowing the user to customize 
the screen layout. 

Main Menu  
The Main Menu provides access to the entire functionality of the program. The available functions 
are as listed below: 

MENU ITEM  FUNCTIONALITY 

Tools 

View Logs… View logs on the carried out operations 

Send Log Files Compress and send the log to the Paragon Support Team 

Recovery Media Builder… Restore the system even when the current operating system 
cannot boot anymore 

Check Recovery Disks… Verify the recovery media for integrity and ability to boot from 

File Transfer Wizard… Transfer data from any media 

Settings... Edit the general settings of the program  

Exit  Exit the program 

Changes 

Save to Scheduler… Schedule pending operations 

Undo `the last virtual 
operation` 

Cancel the last virtual operation on the List of Pending Operations 
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Redo `the last virtual 
operation` 

Cancel the last undo virtual operation on the List of Pending 
Operations 

View Changes…  Display the List of Pending Operations 

Apply Changes  Launch the real execution of virtual operations 

Discard All Changes  Cancel all virtual operations on the List of Pending Operations 

Reload Disk Info  Refresh the current information about disks 

Wizards 

Undelete Partitions… Recover an accidentally deleted partition 

One Button Copy Wizard Create a hard disk copy just by pressing one button 

Copy Hard Disk… Create a hard disk copy 

Schedule Hard Disk Copy… Set a timetable for a hard disk copy 

Copy Partition… Create a partition copy 

Schedule Partition Copy… Set a timetable for a partition copy 

Hard Disk 

Convert to Basic… Convert a dynamic MBR disk containing simple volume(s) into a 
basic MBR disk 

Update MBR Update MBR (Master Boot Record) of the selected hard disk 

Change Primary Slots… Modify the primary partitions enumeration for the selected hard 
disk 

Copy Hard Disk…  Create a copy of the selected hard disk 

Change SID… Change SID (Security Identifier) value of any found Windows 
installation 

Properties… Get in-depth information on the properties of selected hard disk 

Partition 

Create Partition… Create a partition 

Format Partition… Format a partition 

Delete Partition… Delete a partition 

Assign Drive Letter… Assign drive letter to the selected partition 
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Remove Drive Letter… Remove drive letter for the selected partition 

Hide Partition… Make the selected partition unavailable for the operating system 

Unhide Partition… Make the selected partition available for the operating system 

Mark Partition as Active Make the selected partition bootable by default 

Mark Partition as Inactive Make the selected partition non-bootable by default 

Change Volume Label… Change volume label of the selected partition 

Change Serial Number… Change serial number of the selected partition 

Change Partition ID… Change identifier of the selected partition 

Change SID… Change SID (Security Identifier) value of any found Windows 
installation 

Test Surface… Test surface of the selected partition/block of free space 

Check File System 
Integrity…

Check the selected partition for possible file system errors 

Properties… Get in-depth information on the properties of selected partition 

View 

Layouts  Manage the Launcher layout with several predefined profiles 

Toolbar  Manage the Tool Bar representation: show / hide standard and 
navigation buttons, text labels and large icons 

Status Bar  Display the Status Bar 

Common Tasks Bar  Display the Common Tasks Bar 

Disk Map Legend  Display the Disk Map legend 

Properties and Commands  Display the Explorer Bar 

Disk Map Location  Select whether the Disk Map will be located on the top of the 
main window or at the bottom 

Help 

Help  Open the Help system (you can also do it by pressing F1) 

About  Open the dialog with information about the program 
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�  
The Main Menu contents available at the moment may vary depending on the 
selected object. 

Tool Bar  
The Toolbar provides fast access to the most frequently used operations: 

BUTTON FUNCTIONALITY 

 
Copy a hard disk 

 
Copy a partition 

 
Open the Help system 

Virtual Operations Bar  
The program supports previewing the resulting layout of hard disks before actually executing 
operations (so-called virtual mode of execution). In fact, when the virtual mode is enabled, the 
program does not accomplish operations immediately, but places them on the List of Pending 
Operations for later execution. 

The Virtual Operations Bar enables to manage pending operations. 

BUTTON FUNCTIONALITY 

 Cancel the last virtual operation on the List of Pending 
Operations 

 Cancel the last undo virtual operation on the List of 
Pending Operations 

 Display the List of Pending Operations 

 Launch the real execution of virtual operations 

 Cancel all virtual operations on the List of Pending 
Operations 

 

�  

Virtual mode is an effective way of protection from any troubles, since no 
operations will be executed until clicking the Apply button for confirmation, 
thus giving a second chance to weigh all pros and cons of this or that 
particular operation. The program politely reminds the user that there are 
unsaved changes by showing the following window: 
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Common Tasks Bar  
The Common Tasks Bar is located on the left side of the main window. It is intended for easy access 
to the program's wizards. 

The bar contains several tabs named Copy Tasks, Schedule Copy Tasks, Tools and News and 
Documentation. Each of these contains a separate button bar which can be folded by clicking it. 

Copy Tasks 

 
Starting the One Button Copy Wizard to clone a hard disk with one 
click. 

 
Starting the Copy Hard Disk Wizard to copy a hard disk. 

 
Starting the Copy Partition Wizard to copy a partition. 

Schedule Copy Tasks 

 
Starting the Copy Hard Disk Wizard to set a timetable for a hard disk 
copy. 

 
Starting the Copy Partition Wizard to set a timetable for a partition 
copy. 

Tools 

 
Starting the Undelete Partitions Wizard to recover an accidentally 
deleted partition. 

News and Documentation 

 
Launching the help system (you can also do it by pressing F1). 

 
Opening the page which contains information about the program. 
This page will be displayed in the Explorer Bar. 

Disk Map  
The Disk Map is displayed in the Explorer Bar when the Disk View tab is selected. It is located either at 
the top or at the bottom of the window, depending on the state of the Disk Map Location option 
(Main Menu: View > Disk Map Location). 
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As the name infers, the Disk Map displays the layout of physical and logical disks. Physical disks are 
represented with rectangle bars that contain small-sized bars. These small-sized bars represent logical 
disks. Their color depends on the file system of the appropriate partition. 

 

Large-sized bars display the following information about physical disks: 

• Manufacturer, 

• Model. 

Small-sized bars display the following information about logical disks: 

• Serial number, 

• Drive letter, 

• Total size, 

• File system. 

Furthermore, it is possible to estimate the used disk space by looking at the size of the bar’s shaded 
area. The program offers to choose from several types of the disk layout scaling. It’s done especially 
to increase the program usability. For instance, if you’ve got a high capacity hard drive containing 
both very large (more than 100 GB) and rather small (less than 10 GB) partitions, you can select the 
logarithmic type to make all partitions readable, otherwise (selecting the linear type) you won’t be 
able to see small partitions at all, but thing strips. On the other hand, if the proportional disk layout is 
critical for you, the linear type is exactly what you need.  

Nevertheless there’s a compromise solution – linear scaling with the minimal limit to small partitions. So 
if a partition is too small it will remain readable. 

Just click on the arrow icon on the top right side of the Disk Map to select the desired scaling type. 

 

Disk Map is synchronized with the Explorer Bar. Thus by selecting a disk on the Disk Map, the Explorer 
Bar will automatically display detailed information on it. 
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�  
The drag-and-drop functionality is not available when the logarithmic type of 
the disk layout is selected. 

Explorer Bar 
The Explorer Bar is located in the center of the main window which emphasizes its importance. The 
bar displays reference information including: 

• The help system; 

• General information on the product including its name, version and a list of helpful links; 

• Detailed information about disks selected on the Disk Map; 

• List of scheduled operations. 

According to these categories the Explorer Bar has several tabs: 

• Disk View, which offers the user the following options: 

- Partition List to get a clear-cut picture of the current state of the system hard disks/partitions; 

- Properties to view detailed information on the selected partition/hard disk in the bright 
graphical form. 

�  
You can switch between these components by clicking tabs on the left side of 
the Explorer Bar. 

• Scheduled Tasks, which gives the user the possibility of browsing and editing scheduled 
operations and the program scripts. 

• Help, which contains the program help and general information on the product. 

You can access the desired information by clicking on the appropriate tab. 

The Explorer Bar is a fully-functional embedded HTML browser, which offers the possibility to address, 
for example, the company's website to look through important technical notes or download the 
latest updates without having to close the program.  

The program help is also HTML-oriented. You can read it and follow external links from to get 
additional information. 
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To easily navigate through browsed pages, the program provides the following functionality: 

BUTTON FUNCTIONALITY 

 
Return to the previously 
browsed page 

 
Open the next browsed page 

 
Stop loading the current page 

 
Refresh the contents of the 
current page 

Partition List 
The Partition List is another helpful tool that enables you to get a clear-cut picture of the current state 
of the system hard disks/partitions. Partitions are sorted according to their starting position. For every 
item of the list there is the possibility to call the context-sensitive popup menu with available 
operations. Besides, the program provides detailed information on all hard disks/partitions found in 
the system including the following properties: 

- Name, 

- Volume label (if exists), 

- Partition type (Primary/Extended /Logical), 

- File system type, 
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- Size, 

- Amount of used and unused (free) space, 

- Start/End cylinder, 

- Start/End head, 

- Start/End sector, 

- Free size in sectors/bytes, 

- Active/Inactive attribute, 

- Hidden/Unhidden attribute. 

You may customize outlook of the Partition List by clicking on the arrow icon on the top right side of 
the panel. 

 

By marking a checkbox opposite the required item you can choose whether to display it or not. 
Besides, you can change its order by pressing the Move up or Move down buttons. 

If you don’t need the Disk Map, please click the shown below icon to disable it: 

 

Legend Bar 
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The Legend Bar explains the color scheme used for disk and partition presentation. You can hide (or 
show) the bar with the appropriate Main Menu item: View > Disk Map Legend. When it is activated it 
can be found at the bottom of the Explorer Bar.  

The program distinguishes between the following types of known file systems: 

   - FAT16/32, 

   - NTFS, 

   - Linux Ext2/3/4, 

   - Linux ReiserFS, 

   - Apple HFS. 

Status Bar  
This is the bottom part of the main window. The Status Bar displays menu hints, for each item the 
cursor points to. 

The user can hide (or show) the bar with the appropriate Main Menu item: View > Status Bar. 

Settings Overview 
The Settings dialog is available from the Main Menu: Tools > Settings. All the settings are grouped into 
several sections, which functions are described in the following paragraphs. The list of sections is 
placed on the left side of the dialog. By selecting a section from the list, you can open a set of 
options. 

�  
To get a detailed description to any setting, control, or field of the program just 
click the hint button and then the object you need. 

General Options  
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This section contains a set of general options that will be taken into account during any operation 
carried out with the program: 

• Enable data loss protection. Mark the checkbox to make the program work in the fail-safe 
mode (also referred to as the data-loss protection mode), which ensures reliability for 
operations by maintaining a special journal. In case of a hardware malfunction, power 
outage or an OS failure happened in the middle of a data-sensitive operation (resize, move, 
merge, redistribute, change cluster size, etc.), the program will ask to insert the bootable 
Recovery CD and automatically complete the interrupted operation, thus reviving the 
corrupted partition. 

�  
It is strongly recommended to enable this option. 

Backup Image Options  
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This section contains a set of options that will be taken into account during backup/restore 
operations: 

• Control archive integrity. Mark the checkbox to guarantee that all backup images created 
with the program are 100 percent flawless. If you decided not to control the archive integrity, 
the backup operation would take about 3-5% less time. 

• Set image file names automatically. Mark the checkbox to make the program automatically 
set a file name for every volume of a complex backup image. Otherwise you will need to do it 
manually during the backup operation. 

• Compression level. From the pull-down list you can select the desired compression level for 
backup images that will be used by default. 

• Enable image splitting. Mark the checkbox to automatically split every backup image to 
volumes of a particular size. 

�  
Splitting images enables to tackle problems caused by a maximum file size 
limitation of some file systems. 

• Maximum split size. With the spinner control you can specify a maximum size for backup 
volumes. 

Partitioning Options 
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This section contains a set of options that will be taken into account during partitioning operations: 

• Enable 64 KB cluster size for FAT16. Mark the checkbox to enable 64KB clusters for FAT16 
partitions. Thus you will be able to create FAT16 partitions up to 4GB in size 

�  

Due to the maximum cluster size of 32KB for Windows 95/98/ME or MS DOS, 
FAT16 partitions larger than 2GB are not reliably accessible under these 
operating systems. 

• Request confirmation before partition deletion. Mark the checkbox to activate an additional 
security mechanism. Thus when going to delete a partition you will be automatically 
requested to enter its label. 

• Request confirmation when converting FAT16 to FAT32. Mark the checkbox to automatically 
request confirmation before converting FAT16 to FAT32. There are a number of situations when 
this kind of conversion is the only way out to accomplish the operation. For instance, you are 
going to migrate your system to a larger hard disk with the proportional resize of existing 
partitions, what is very convenient. As a result you can get original FAT16 partitions go beyond 
the 4GB limit. Thus without conversion to FAT32, this operation will in no way be possible to 
accomplish. The same goes for any copy hard disk/partition or restore hard disk/partition 
operation involving an extra upsizing. 

General Copy and Backup Options  
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This section contains a set of options that will be taken into account during copy and backup 
operations: 

• HDD raw processing. Mark the checkbox to copy/back up a hard disk in the sector-by-sector 
mode, thus ignoring its information structure (e.g. unallocated space or unused sectors of 
existing partitions will be processed as well). This can help to avoid problems with hidden data 
created by certain applications or the system administrator. However, it will take more time to 
accomplish the operation. 

• Partition raw processing. Mark the checkbox to copy a partition in the sector-by-sector mode 
to successfully process unknown file systems. However it is not recommended to enable this 
option when working with supported file systems as it takes more time to accomplish the 
operation. 

• Perform incremental copy. Mark the checkbox to only copy changes on the hard disk from 
the moment of the last copy operation. The program will perform comparison between a 
previous copy of the hard disk and its current state. Only sectors that are different will be 
updated, thus considerably decreasing the amount of data to write. 

• Skip OS auxiliary files. Mark the checkbox to skip OS auxiliary files (like pagefile.sys, hiberfil.sys, 
etc.), thus reducing the operation time and the resulted size of the backup image. 

�  
By clicking the link at the bottom of the window you can jump to the 
Copy/Backup Exclude Options. 
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Hot Processing Options  

 

In this section you may configure the hot processing mode: 

• Enable hot processing. Mark the checkbox to enable the so called hot data processing mode 
that is specially designed to process data without restarting your operating system. 

• Hot processing technology. From the pull-down list you can select the required hot processing 
technology. 

• Always use hot processing. Select the option to process partitions without making them 
locked. Thus you will be able to keep working with them as usual. 

• Use hot processing only when partition is locked. Select the option to use the hot processing 
only when partitions are locked and cannot be processed without restarting the computer. 
Please keep in mind, that once you start any operation on a partition in this mode, it will 
automatically be locked by the program, thus you won't be able to keep working with it as 
usual. 

• Hot processing temporary drive. Here you can select a disk drive that will be used to store the 
temporary hot backup data (by default – C:). 

• Attempts to start VSS. Here you can set how many attempts to start Microsoft VSS the program 
is to do before automatically rebooting the system and accomplishing the operation in a 
special boot-up mode. 
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• Timeout between attempts (in seconds). Here you can set a time period between different 
attempts to start Microsoft VSS. 

• Switch between hot processing technologies. Mark the checkbox to automatically switch 
between Paragon Hot Processing and Microsoft VSS if one of them is unavailable at the 
moment. 

�  
By clicking the link at the bottom of the window you can jump to the Run 
during Backup Options. 

E‐Mail Options 

 

This section contains a set of options that will be taken into account during the Send log files and 
Send e-mail notification operations: 

• Outgoing mail server (SMTP). To send messages by using the built-in mail client, it is necessary 
to have access to a computer running an SMTP (Simple Mail Transfer Protocol) server. All 
outgoing messages are first sent to the SMTP server, which in its turn delivers them to the 
required recipients. The address may be represented as a traditional Internet host name (e.g.: 
mail.com) or as an IP numeric address (e.g. xxx.xxx.xxx.xx). 

• User e-mail address. Specify an e-mail address that has been assigned by the Internet Service 
Provider or organization's e-mail administrator. 

• My outgoing server requires authentication. Activate the option to allow the program to make 
authentication on the server before sending messages. 
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- User name. Enter the name that will be used to log in to the e-mail account. 

- Password. Enter the password that will be used to access the mail server. 

• Send e-mail notification on apply. Specify an e-mail to send notifications on the carried out 
operations.  

- Send mail in HTML format. Activate the option to create messages in the HTML format instead 
of plain text. 

- Send complete report after applying operations. Activate the option to create an in-depth 
report on the carried out operations and send it after performing the last operation. 

- Send graphical view of the disk sub-system before and after apply. Activate the option to 
allow the program to attach two pictures of the disk layout made before and after the 
operation is completed. 

�  
By clicking the link at the bottom of the window you can jump to the Operation 
Dependency Options. 

Virtual Mode Options 

 

In this section you may configure the virtual mode: 

• Allow virtual mode. Mark the checkbox to enable the virtual mode. It is an effective way of 
protection from any troubles, since no operation will be executed until confirmation, thus 
giving you a second chance to weigh all pros and cons of this or that particular operation. 



49 

Copyright© 1994-2010 Paragon Software Group. All rights reserved. 

�  
We strongly recommend you to enable this mode. 

• Close progress dialog automatically. Mark the checkbox to automatically close the progress 
dialog after accomplishing operations. 

Copy/Backup Exclude Options 

 

In this section the program enables to specify what data should be automatically ignored during 
copy and sector-based backup operations. You can filter certain files or folders either by the manual 
selection or by creating masks, what is more preferable. Thus you will be able to effectively manage 
contents of your backup images or partition/hard disk copies. 

By default, there are no available filters. To create a filter, please click the Add Category… button. 

 

In the opened dialog the program allows the user to define the following parameters: 

• Name. Give to the filter any name you like, but try to use an informative one; 
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• Filter. Press the Browse button to select files or folders you would like to be excluded or specify 
a filter mask by using * or ? wildcards; 

• Description. Add a short description to the filter not to miss it up later. 

Click the OK button and you will get a new item on the list of filters. By marking/unmarking a 
checkbox opposite its name you can choose whether to use it or not. 

�  
By clicking the link at the bottom of the window you can jump to the General 
Copy and Backup Options. 

Log Files Options 

 

In this section you can specify a storage life span for the stubact.log file: 

• Infinite not to empty the file ever; 

• Minimal to have the file emptied all the time; 

• Custom to set a certain storage life span for the file. Please note, once the defined period has 
been expired, the file will be emptied. 

�  

We strongly recommend you not to choose the Minimal option, as in case of 
having problems with the program, our Support Team won’t be able to study 
operation logs, thus help you out. 
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Operation Dependency Options 

 

This section contains a set of options that will be taken into account when the Send e-mail 
notification on apply function is enabled. By marking/unmarking a checkbox opposite the required 
operation you can choose whether to receive an e-mail notification on its completion or not. 

�  
You won't be notified if an operation requires the system restart. 

Viewing Disk Properties  
The main tool to view in-depth information on the properties of hard disks is the Disk Map. It 
represents the actual state of the computer’s hard disks. 

Generally the hard disks are represented on the map by rectangular bars, which also contain small-
sized bars. The small-sized bars represent logical disks (partitions). When you select a large-sized bar, 
the Explorer Bar displays information about the disk in a bright, graphical form. 
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The model and serial number of the disk serve as the title of the browsed page. The disk layout is 
shown in form of a circular graph, where the color of a sector corresponds to a file system of an 
appropriate partition. On the right you may see a table, which contains the following information: 

• Type of hard disk (basic or dynamic), 

• Total size (in GB), 

• Information on geometry of the disk (amount of sectors per track, heads and cylinders). 

Below there is a list of available wizards. If you click a corresponding record the appropriate wizard 
will be started. All default values for the operation parameters will correspond to the disk’s settings. 
The list of wizards contains a detailed description of tasks that can be performed by the wizard. This 
nullifies the possibility of selecting the wrong wizard. 

 

When you select a small-sized bar (i.e. corresponding to a logical disk) the Explorer Bar will display 
information on it as well. The page title will contain a drive letter, which is assigned to the disk. The 
disk layout graph will be colored in accordance with the volume ratio of the used space to the free 
space (the light colored sector). The table on the right will contain the following information: 

• Volume label (if available), 

• Type of the logical disk, 

• File system (represented by the color of the graph and the selected bar), 

• Total size, used space and free space (in GB or MB). 
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Below there is a list of wizards, which may be called for this disk. All default values of parameters will 
correspond to the disk settings. 

Building Recovery Media  
Recovery Media Builder can help you accomplish the following operations: 

• Prepare the Linux/DOS recovery environment (included in the installation package) on 
external media (CD, DVD, or flash memory) to boot and run utilities under Linux or PTS DOS, 
and that way to get access to your hard disk for maintenance or recovery purposes (strongly 
recommended); 

• Prepare a custom Linux/DOS recovery environment by adding any data you like to the 
standard image; 

• Prepare bootable recovery environment from any ISO image, including our WinPE 2.1 ISO 
image; 

• Create from the master CD the Linux/DOS or WinPE recovery environment on a CD/DVD disc, 
or flash memory. 

Startup 
There are several ways to start the Recovery Media Builder: 

• In the Main Menu: select Tools > Recovery Media Builder… 

Setup 
The wizard offers the following steps to build recovery media: 

• Type of the recovery media. You can place it either on a CD/DVD disc, or flash memory. 

 

• Contents of the recovery set. You’ve got the following options: 

- Prepare the Linux/DOS recovery environment (included in the installation package); 

- Prepare a custom Linux/DOS recovery environment by adding any data you like to the 
standard image (not available for flash memory); 

- Prepare bootable recovery environment from any ISO image, including our WinPE 2.1 ISO 
image; 

- Create from the master CD the Linux/DOS or WinPE recovery environment. 
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• A recording device. The appropriate external media (CD/DVD, or flash memory) needs to be 
available in the system. 

�  
You can make an ISO image instead of burning a CD/DVD by selecting the 
Emulator drive. 

• CD/DVD writing parameters (in case you select this kind of media). Writing parameters include 
writing speed (maximum or minimum) and the ability of ejecting the recorded disc after 
completing the operation. 

 

The program supports CD-R, CD-RW, DVD-R, DVD+R, DVD-RW, DVD+RW, DVD-R, DVD+R double layer 
and also Blu-ray discs.  

�  

If the inserted disc is not empty, the wizard will suggest erasing its contents (if 
possible). Once the operation has been confirmed, the program will delete the 
re-writable disc's contents and begin the recording process. 

Result 
As a result of the operation, you receive recovery media to use in most emergencies. 

Copy Tasks 
In this chapter you will find all the information necessary to make a copy of a hard disk or a separate 
partition. 

Cloning Hard Disks 
You can clone a hard disk of any file system. During the hard disk copying process, the program 
moves controlling records of used partitioning scheme, the bootstrap code and on-disk partitions. 
That’s why this operation cannot be substituted by simply copying all on-disk partitions. 

The program offers two wizards that can help to clone a hard disk, i.e. the Copy Hard Disk Wizard 
and the One Button Copy Wizard. Both wizards provide nearly identical functionality, but different in 
the work concept. 
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Copy Hard Disk Wizard 
The Copy Hard Disk Wizard is a traditional-like wizard. By going through its steps, you configure all the 
necessary settings to launch the copy operation. To minimize the possibility of making any mistake, 
the wizard provides auxiliary information on every single option. Moreover you can get an in-depth 
description to any setting, control, or field of the wizard just by clicking the hint button and then the 
object you need. 

�  
You need at least two hard disks to carry out this operation. 

Startup 
There are several ways to start the Copy Hard Disk Wizard: 

• In the Main Menu: select Wizards > Copy Hard Disk… 

• On the Common Tasks Bar: click the Copy Hard Disk item of the Wizards menu. 

• In the Toolbar: click the Copy Hard Disk button. 

Setup 
The wizard offers the following steps to accomplish the copy hard disk operation: 

• The hard disk to copy. Select a hard disk you want to copy. 

 

• The target hard disk. Select a hard disk (if several) where all data of the source disk will be 
copied to. 

 

• Copy parameters. The wizard enables to specify the following options: 
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Copy options 

- HDD raw copy to copy the hard disk in the sector-by-sector mode, thus ignoring its 
information structure (e.g. unallocated space or unused sectors of existing partitions will be 
processed as well). This can help to avoid problems with hidden data created by certain 
applications or the system administrator. However, it will take more time to accomplish the 
operation. 

- Partition raw copy to copy the on-disk partitions in the sector-by-sector mode to successfully 
process unknown file systems. However it is not recommended to enable this option when 
working with supported file systems as it takes more time to accomplish the operation. 

- Perform incremental copy to only copy changes on the hard disk from the moment of the 
last copy operation. The program will perform comparison between a previous copy of the 
hard disk and its current state. Only sectors that are different will be updated, thus 
considerably decreasing the amount of data to write. 

- Change masks for files to exclude from copy to manage contents of the resulted duplicate. 
By default the program will take into account exclude filters set in the Settings dialog. If you 
need to change them, please mark the checkbox and specify additional filters on the next 
page of the wizard. 

Resize options 

- Remove free blocks between partitions not to keep blocks of free space between partitions 
on the targeted hard disk. 

- Copy data and resize partitions proportionally to make the program proportionally change 
the size of partitions keeping their relative order intact. The option can be useful when 
upgrading the hard disk to a larger one. 

Verification options 

This section allows you to define whether the Surface and/or the Writing verification tests will 
be accomplished during the operation. 



57 

Copyright© 1994-2010 Paragon Software Group. All rights reserved. 

Result 
After the operation is completed, you receive a fully functional duplicate of the existing hard disk. 

�  
To make a Win2K+ operating system bootable on different hardware, please 
additionally complete the P2P Adjust OS Wizard. 

Available operation scenarios: 

• Cloning System Hard Disk 

One Button Copy Wizard 
The One Button Copy Wizard is a new approach of accomplishing such a technically complicated 
operation as cloning of a hard disk. In fact with its help you can do it just by pressing one button. 

Restrictions 

So to successfully accomplish the operation your system should meet the following requirements: 

• At least two hard disks, one of which should contain data and the other is empty 

• The destination hard disk should have enough space to take contents of at least first partition 
of the source disk 

Startup 
There are several ways to start the One Button Copy Wizard: 

• In the Main Menu: select Wizards > One Button Copy Wizard… 

Setup 
If your system meets the mentioned above requirements, the wizard will automatically accomplish 
the copy operation after a ten-second pause. 
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There are a number of options you can modify: 

• HDD raw copy to copy the hard disk in the sector-by-sector mode, thus ignoring its information 
structure (e.g. unallocated space or unused sectors of existing partitions will be processed as 
well). This can help to avoid problems with hidden data created by certain applications or the 
system administrator. However, it will take more time to accomplish the operation. 

• Partition raw copy to copy the on-disk partitions in the sector-by-sector mode to successfully 
process unknown file systems. However it is not recommended to enable this option when 
working with supported file systems as it takes more time to accomplish the operation. 

• Perform incremental copy to only copy changes on the hard disk from the moment of the last 
copy operation. The program will perform comparison between a previous copy of the hard 
disk and its current state. Only sectors that are different will be updated, thus considerably 
decreasing the amount of data to write. 

• Change masks for files to exclude from copy to manage contents of the resulted duplicate. 
By default the program will take into account exclude filters set in the Settings dialog. If you 
need to change them, please mark the checkbox and specify additional filters on the next 
page of the wizard. 

• Copy without free space blocks to arrange partitions one after another. 

• Resize proportionally to proportionally change the size of partitions keeping their relative order 
intact. 

To do that, press the Pause button, to continue execution press Start. To interrupt the operation, press 
the Cancel button. 
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Result 
After the operation is completed, you receive a fully functional duplicate of the existing hard disk. 

�  
To make a Win2K+ operating system bootable on different hardware, please 
additionally complete the P2P Adjust OS Wizard. 

Cloning Partitions 
You can duplicate partitions to protect oneself from downtime in case of a system malfunction or for 
cloning sample partitions. The program enables to duplicate all partition data including files, the 
exact structure of directories and file system metadata (location of files, security information, access 
quotas, etc.). 

The Copy Partition Wizard will help you copy a partition of any file system. To minimize the possibility 
of making any mistake, the wizard provides auxiliary information on every single option. Moreover 
you can get an in-depth description to any setting, control, or field of the wizard just by clicking the 
hint button and then the object you need. 

Startup 
There are several ways to start the Copy Partition Wizard: 

• In the Main Menu: select Wizards > Copy Partition… 

• On the Common Tasks Bar: click the Copy Partition item of the Wizards menu. 

• In the Toolbar: click the Copy Partition button. 

Setup 
The wizard offers the following steps to accomplish the copy partition operation: 

• The partition to copy. Select a partition you want to copy. 

 

• Destination disk. Select a hard disk with enough unallocated space to perform the operation. 
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�  

The program enables to copy a partition to a block of free space, which is 
smaller than the partition itself, taking into account only actual amount of 
data. 

• Copy parameters. The wizard enables to specify the following options: 

 

- Partition size. Define the size (in Mb) of the copied partition. 

- Free space before. Define the position (in Mb) of the copied partition relative to the 
beginning of the available range of disk space. 

- Free space after. Define the amount of trailing free space (in Mb) at the end of the available 
range of disk space. 

�  
Partition size and position may also be defined by using the drag-and-drop 
technique. To do that, just carry out the required operation on the Disk Map. 

Result 
After the operation is completed you receive a fully functional duplicate of the existing partition. 

�  
To make a Win2K+ operating system bootable on different hardware, please 
additionally complete the P2P Adjust OS Wizard. 

Partition Management 
In this chapter you will find all the information necessary to carry out partitioning operations 
supported by the program. 

Basic Partitioning Operations 
Here you can learn how to accomplish basic partitioning operations (create, format, delete). 
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Creating Partitions 
The program provides the ability to create a new partition by using the DOS partitioning scheme. This 
operation can be accomplished with the Create Partition Dialog. 

Restrictions 
1. Do not use the Create Partition function in order to undelete the last deleted partition. 

2. The program cannot create new partitions on Dynamic Disks. The current version of the 
program supports only hard disks that use the DOS partitioning scheme (in Windows 2000 and 
XP these disks are named Basic Disks). 

3. According to the rules of the DOS partitioning scheme, the following combinations of partitions 
cannot be created: 

- Two Extended Partitions on one hard disk 

- Five or more Primary partitions on one hard disk 

- If there is an Extended Partition on the disk, only three Primary partitions are allowed 

4. The program allows creating new partitions only within blocks of un-partitioned space. It 
cannot convert a free space on an existing partition to a new partition. 

Startup 
In order to start the operation you should take the following steps: 

1. Select a block of free space on the Disk Map; 

2. Call the Create Partition Dialog to set up the operation. There are several ways to do it: 

- Select in the Main Menu: Partition > Create Partition. 

- Call the popup menu for the block of free space (right click of the mouse button) then 
select the menu item: Create Partition. 

Setup 
Initially the program suggests some consistent values for all parameters. In most cases, you can just 
press the Yes button to confirm the operation. 
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• Define whether the partition will be Primary, Extended or Logical. You can choose the desired 
partition type from the pull-down list. As a matter of fact, the available alternatives 
fundamentally depend on the selected block of free space - within the Logical free space, 
only Logical partitions can be created; Within the Primary free space, both Primary partitions 
or the Extended Partition can be created. 

• Partition Size. Define the size (in Mb) of the new partition. 

• Free space before. Define the position (in Mb) of the new partition relative to the beginning of 
the block of free space. 

• Free space after. Define the amount of trailing free space (in Mb) at the end of the new 
partition. 

�  

Partition size and position may also be defined by using the drag-and-drop 
technique. To do that, just carry out the required operation on the Disk Map. 
The virtual operations are to be available. 

• File system for new partition. From the pull-down list select a file system the newly created 
partition will be formatted to, otherwise the partition will remain unformatted (so that it will not 
be ready to use). 

• Volume label. Enter a label for the selected partition in this textual field. It is an irrelevant 
parameter usually used for drive identification. 

• Drive letter assignment. The pull-down list contains vacant drive letters that can be associated 
with the newly formatted partition. 

In addition, there is the possibility to make further detailed settings (although the default values will 
do in most cases). To activate the advance mode, you need to click the More options button at the 
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foot of the dialog page. Depending on the chosen file system, the following options become 
available: 

 

• Use OS built-in routine. Mark the option to restrict the available values according to the used 
OS. 

• Whether the surface test will be performed. Define the level of the surface check to make the 
program find bad and unstable sectors and mark them unusable in the file system metadata. 

• The amount of sectors per boot. This parameter is available exclusively for FAT16 and FAT32 file 
systems. Set the number of sectors to be reserved for the boot area on the partition with this 
spinner control. 

• The amount of root entries. This parameter is available exclusively for FAT16 file system. Set the 
maximum amount of files/directories to be placed in the Root Directory on the FAT16 partition. 

• The amount of sectors per cluster. Define the Cluster Size for the formatted partition with this 
spinner control. 

�  
Number of available options depends on the selected file system type. 

Result 
After the operation is completed you receive a fully functional partition. 

Formatting Partitions  
Any partition should contain some file system to be used for keeping data. The process of installing a 
file system is commonly known as formatting. A huge variety of file systems have been developed 
these days. 

Supported File Systems 
The program provides the ability to format partitions of the following file systems: 

   - FAT12 & FAT16 

   - FAT32 

   - NTFS 

   - Ext2 

   - Ext3 
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   - Linux Swap v. 2 

   - Apple HFS 

This operation can be accomplished with the Format Partition Dialog. 

Startup 
In order to start the operation you should take the following steps: 

1. Select a partition on the Disk Map; 

2. Call the Format Partition Dialog to set up the operation. There are several ways to do it: 

- Select in the Main Menu: Partition > Format Partition. 

- Call the popup menu for the selected partition (right click of the mouse button) then select 
the menu item: Format Partition. 

Setup 
Initially the program suggests some consistent values for all parameters. In most cases, you can just 
press the Format button to confirm the operation. 

 

• File system. From the pull-down list select the desired file system type. In fact, the program 
displays only those file systems that can correctly be placed to the selected partition, taking its 
capacity into account. 

• Volume label. Enter a label for the selected partition in this textual field. It is an irrelevant 
parameter usually used for drive identification. 

In addition, there is the possibility to make further detailed settings (although the default values will 
do in most cases). To activate the advance mode, you need to click the More options button at the 
foot of the dialog page. Depending on the chosen file system, the following options become 
available: 
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• Use OS built-in routine. Mark the option to restrict the available values according to the used 
OS. 

• Whether the surface test will be performed. Define the level of the surface check to make the 
program find bad and unstable sectors and mark them unusable in the file system metadata. 

• The amount of sectors per boot. This parameter is available exclusively for FAT16 and FAT32 file 
systems. Set the number of sectors to be reserved for the boot area on the partition with this 
spinner control. 

• The amount of root entries. This parameter is available exclusively for FAT16 file system. Set the 
maximum amount of files/directories to be placed in the Root Directory on the FAT16 partition. 

• The amount of sectors per cluster. Define the Cluster Size for the formatted partition with this 
spinner control. 

�  
Number of available options depends on the selected file system type. 

Result 
After the operation is completed you receive a fully functional partition formatted to the specified 
file system. 

Deleting Partitions 
With the Delete Partition Dialog you can delete a partition on a hard disk partitioned with the DOS 
partitioning scheme. Unlike the majority of other utilities (Windows Disk Manager included), the 
program can not only remove references to the deleted partition from the Partition Table, thus 
making it unavailable for the operating system, but also enables to irreversibly destroy its data. This 
feature will guarantee security of your personal information. 

Startup 
In order to start the operation you should take the following steps: 

1. Select a partition on the Disk Map; 

2. Call the Delete Partition Dialog to set up the operation. There are several ways to do it: 

- Select in the Main Menu: Partition > Delete Partition. 

- Call the popup menu for the selected partition (right click of the mouse button) then select 
the menu item: Delete Partition. 

Setup 
Initially the program suggests you just to remove references to the selected partition from the 
Partition Table.  
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• Enter the volume label to confirm deleting. To confirm deletion of the selected partition, enter 
its Volume Label. The current volume label is displayed above. 

• Do not ask volume label next time. Mark the option to inhibit confirmation next time you start 
the dialog. 

Result 
By default, the operation takes only a fraction of a second. However, the program waits until 
Windows completes the modification of the disk layout. In case you decide to wipe the on-partition 
data as well, the operation will take much longer, depending on the set wipe parameters. 

Advanced Partitioning Operations 
Here you can learn how to accomplish advanced partitioning operations (undelete). 

Undeleting Partitions 
When simply deleting a partition (without additional wiping) disk management software only 
removes references to it in the Partition Table, thus leaving the possibility to recover it later. 

The program enables to find and recover these partitions. A restored partition will be fully functional, 
as long as other partitions were not created, moved or exceeded the disk space occupied by that 
partition. That is why the program offers this function only for blocks of free space. 

The operation can be accomplished with the Undelete Partition Wizard. 

Startup 
There are several ways to start the Undelete Partition Wizard: 

• In the Main Menu: select Wizards > Undelete Partitions… 

• On the Common Tasks Bar: click the Undelete Partition item of the Wizards menu. 

• Select a block of free space on the Disk Map and click the Recover Lost Partitions item on the 
page that appears in the Explorer Bar. 

• Call the popup menu for the block of free space (right click of the mouse button) then select 
the menu item: Recover Lost Partitions… 

Setup 
The wizard offers the following steps to accomplish the undelete partition operation: 

• Free blocks to scan for lost partitions. Choose a free block from a tree-like list of available hard 
disks. 
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• Search method. By default, the wizard selects the fastest search method for your operating 
system. In most cases that will do to find any accidentally deleted partition. However if you're 
under Windows XP for instance (the Conventional Search option is selected), but the deleted 
partition you're looking for has been created with the Disk Management utility under Vista, the 
wizard won't be able to find this partition, unless you manually select the appropriate option 
(Quick Search for Partitions Created by Vista or Later OS). Moreover if the wizard still fails to 
find the partition you need, you can select the Thorough Search option to scan every single 
sector in the specified search area to get the most accurate results. 

 

�  
To know more on the available search methods, please use the context 
sensitive hint system. 

• File system filter. By default, the wizard will search for all known file systems. However, by 
clicking on the appropriate option on the second page of the wizard, you can specify only 
those file systems you need. 

 

• A partition to undelete (if several). By default, the program searches records of any deleted 
partition ever existed on the selected block of free space. So you can get several partitions to 
choose from. 
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Most likely the required partition will be found first. If so, you may abort the search operation 
by pressing the Stop search button. 

Result 
After the operation is completed you receive a fully functional partition. 

Changing Partition Attributes 
This chapter explains how you can change partition attributes (Active flag, Hidden flag, Partition ID, 
Volume Label, etc.). 

Mark Partition Active/Inactive 
The program enables to set an active/inactive flag for primary partitions of a hard disk. By default, an 
operating system will boot only if its partition is active or bootable. 

In order to mark a partition active/inactive you should take the following steps: 

1. Select a primary partition on the Disk Map. 

2. Call the Mark Partition Active/Inactive Dialog to set up the operation. There are several ways 
to do it: 

- Select in the Main Menu: Partition > Mark Partition as Active/Inactive. 

- Call the popup menu for the selected partition (right click of the mouse button) on the Disk 
Map, then select the menu item: Mark Partition as Active/Inactive. 

 

3. The operation will be performed immediately after confirmation. 
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�  
There can only be one active partition on a hard disk, otherwise your 
operating system will fail to boot. 

Hide/Unhide Partition 
The program allows you to hide/unhide primary and logical partitions. By default, an operating 
system does not mount hidden partitions, thus preventing access to their contents. 

In order to hide/unhide a partition you should take the following steps: 

1. Select a partition on the Disk Map.  

2. Call the Hide/Unhide Partition Dialog to set up the operation. There are several ways to do it: 

- Select in the Main Menu: Partition > Hide/Unhide Partition. 

- Call the popup menu for the selected partition (right click of the mouse button) on the Disk 
Map, then select the menu item: Hide/Unhide Partition. 

3. The operation will be performed immediately after confirmation. 

�  
It is strongly recommended not to hide the system partition. Otherwise your 
operating system will fail to boot. 

Set Label of a Partition 
The Partition Label is a small textual field (up to 11 characters) that is located in the partition's boot 
sector. It is detectable by any partitioning tool and is used for notification purposes only. 

In order to change a partition label you should take the following steps: 

1. Select a partition on the Disk Map. 

2. Call the Change Volume Label dialog to set up the operation. There are several ways to do it: 

- Select in the Main Menu: Partition > Modify > Change Volume Label. 

- On the Explorer Bar: click on the current volume label. 

- Call the popup menu for the selected partition (right click of the mouse button) on the Disk 
Map, then select the menu item: Change Volume Label. 

3. Enter a label for the selected partition. 

 

4. The operation will be performed immediately after confirmation. 
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Change Partition ID 
Partition ID is a file system identifier. It is saved in the Partition Table and is used to quickly detect a 
partition of the supported type. By manually changing its value, you can manipulate accessibility of 
partitions. 

In order to change a partition ID you should take the following steps: 

1. Select a partition on the Disk Map. 

2. Call the Change Partition ID dialog to set up the operation. There are several ways to do it: 

- Select in the Main Menu: Partition > Modify > Change Partition ID… 

- On the Explorer Bar: click on the current partition ID. 

- Call the popup menu for the selected partition (right click of the mouse button) on the Disk 
Map, then select the menu item: Change Partition ID… 

3. Set a new ID for the selected partition. 

 

• Predefined ID. Select from the pull-down list the required ID. 

• Enter ID manually. With the spinner control set the required ID value. It has to be a 1-2 
digit hexadecimal number. 

4. The operation will be performed immediately after confirmation. 

Change Serial Number of a Partition 
FAT16, FAT32, and NTFS file systems include the Serial Number parameter. A partition's serial number is 
saved in the boot sector. Its value is generated while formatting. 

The program enables to modify the serial number parameter for FAT16, FAT32, or NTFS partitions 
without re-formatting. 

In order to change a serial number you should take the following steps: 

1. Select a partition on the Disk Map. 

2. Call the Change Partition Serial Number dialog to set up the operation. There are several ways 
to do it: 
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- Select in the Main Menu: Partition > Modify > Change Serial Number. 

- On the Explorer Bar: click on the current serial number. 

3. Enter a new serial number for the selected partition. It should contain 8 hexadecimal figures 
(0..9 or A..F). The operation cannot proceed until you enter all 8 symbols. 

 

4. The operation will be performed immediately after confirmation. 

Hard Disk Management 
In this chapter you will find all the information necessary to carry hard disk operations supported by 
the program (Update MBR, Convert to Basic, Change Primary Slot). 

Updating MBR 
The program enables to overwrite the current bootable code in the MBR (Master Boot Record) by 
the standard bootstrap code. This can help to repair a corrupted bootable code of a hard disk 
resulted from a boot virus attack or a malfunction of boot management software. 

In order to update MBR of a hard disk you should take the following steps: 

1. Select a hard disk on the Disk Map. 

2. Call the Update MBR dialog to set up the operation. There are several ways to do it: 

- Select in the Main Menu: Hard Disk > Update MBR. 

- Call the popup menu for the selected hard disk (right click of the mouse button) on the 
Disk Map, then select the menu item: Update MBR. 

 

3. The operation will be performed immediately after confirmation. 

Converting Dynamic MBR to Basic 
The program allows you to convert a dynamic MBR disk containing simple volumes into a basic one 
while keeping its contents intact. 

In order to convert a dynamic MBR disk into basic you should take the following steps: 
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1. Select a dynamic MBR disk containing simple volumes on the Disk Map.  

2. Call the Convert to Basic dialog selecting in the Main Menu: Hard Disk > Convert to Basic… 

3. Set the required number of primary partitions if necessary. According to the DOS partitioning 
scheme a hard disk can have up to four Primary partitions. If there is an Extended partition on 
the disk, only three primary partitions are allowed. That is why if a dynamic disk contains 
several simple volumes the program enables to choose the number of primary partitions. The 
rest of them if any will automatically be converted to logical disks within the Extended 
partition. 

 

�  
The program can only process dynamic disks containing solid simple volumes 
(without extension). 

Changing Primary Slot 
Different operating systems apply different approaches to enumeration of the primary partitions. 

In Linux: 

In Linux, every partition has a special symbolic name that encodes a hard disk containing a partition, 
and a partition itself. Partitions are addressed and accessed by using their symbolic names. Symbolic 
names are automatically generated by Linux in accordance with the order of hard disks in BIOS and 
the order of partition records in the Partition Table. Thus changing enumeration of the primary 
partitions can lead to changing of paths to some important resources. 

In DOS: 

The last versions of MS-DOS use a rather sophisticated algorithm for a drive letter assignment. A drive 
letter, which is assigned to a partition, depends on the order of records in the Partition Table. Thus 
changing enumeration of the primary partitions affects the drive letters assignment. In early versions 
of MS-DOS, it could even lead to the unavailability of a partition. 

The program provides the ability to change enumeration of the primary partitions. This feature will 
allow you to fix problems concerning an inappropriate order of partitions. 
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In order to modify enumeration of the primary partitions you should take the following steps: 

1. Select a hard disk on the Disk Map. 

2. Call the Change Primary Slot dialog to set up the operation. There are several ways to do it: 

- Select in the Main Menu: Hard Disk > Change Primary Slot. 

- Call the popup menu for the selected hard disk (right click of the mouse button) on the 
Disk Map, then select the menu item: Change Primary Slot. 

 

3. In the opened dialog you can see the current enumeration of the primary partitions of the 
selected hard disk in the Partition Table. To help you distinguish partitions from one another, 
the program provides the following parameters for every partition: 

- Slot 

- Volume 

- Partition type 

- File system 

- Partition size  

- Volume label 

There are two buttons on the right to move the selected partition up and down within the 
primary part of the Partition Table. 

4. The operation will be performed immediately after confirmation. 

Task Scheduling 
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Automation of operations can really help you out when you’ve got to accomplish certain routine 
operations on a regular basis as it enables to execute them without your involvement while 
optimizing your computer’s work-load. 

Setting a Timetable 
Thanks to the embedded Scheduler, you can set a timetable for execution of any operation. It has 
two categories for time settings (these correspond to appropriate items in the Schedule type menu): 

• Initiating the operation by an event: 

- One time only (i.e. the Once item) 

- When the system starts (i.e. the At System Startup item) 

- When the user logs on (i.e. the At Logon item). 

• Initiating the operation periodically (i.e. Daily, Weekly, Monthly). 

 

You need to select one of the variants. Depending on your choice, the scheduler displays a form 
that enables to set a timetable. 

 

�  

To run the task in the log-off mode, please specify administering login info by 
following the appropriate link in the left lower corner of the page. 

The Shutdown System on Complete option enables to automatically switch off 
the computer on the successful accomplishment of the operation. 

Managing Tasks 
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All scheduled tasks are placed in a separate list, which can be retrieved by clicking the Scheduled 
Tasks tab in the Explorer Bar: 

 

On every task you can get in-depth information, including: 

• The task name 

• The full path to the generated script of the task 

• Scheduled time of launch 

• Statistics on the last launch 

• Scheduled time of the next launch 

• Used account information 

• Comments to the task 

To easily manage tasks, the program enables to arrange them according to a certain characteristic 
just by clicking on the required property. 

�  
This feature can be particularly beneficial when the Scheduled Tasks list 
contains too many items. 

You can also enable/disable, rename, delete, refresh or modify properties of the selected task. 

Task Editor  
With the Task Editor you can easily modify properties of scheduled tasks. To do that, you should take 
the following steps: 

1. Select a task on the Scheduled Tasks list. 

2. Call the Task Editor dialog. There are several ways to do it: 

- Click the Properties button on the Scheduled Tasks list. 

- Call the popup menu for the selected task (right click of the mouse button), then select 
the menu item: Properties. 
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3. In the opened dialog window you can see two tabs - General and Schedule. Click the 
General tab to modify: 

• Full path to the macro-command program-interpreter, which describes the scheduled 
task; 

• Command line for starting the interpreter (i.e. the task described in macro-language) 

• Comments referring to the task 

• The option of enabling/disabling the task. 

By clicking the Schedule tab you can modify the task timetable. 

In order to apply the changes, you need to click the Apply button at the foot of the dialog. 

Creating a Scheduled Task 
You can set a timetable for execution of any operation. For backup and copy operations the 
program offers handy wizards, while all the others can be scheduled with the Save to Scheduler 
dialog. 

To create a scheduled task you should take the following steps: 

1. Make sure the virtual mode of execution is enabled; 

2. Carry out with the program all operations you need to schedule; 

3. Call the Save to Scheduler dialog in the Main Menu: Tools > Save to Scheduler…; 
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4. In the opened dialog enter the required task name and specify the task timetable; 

5. The operation will be performed immediately after confirmation. 

�  
This command is unavailable if there are no operations on the List of Pending 
Operations. 

Extra Functionality 
This chapter describes the supplementary functionality available in the program. 

View Partition/Hard Disk Properties 
The program enables to obtain in-depth information on the properties of hard disks and partitions. 
Besides the general information, such as capacity, used space or file system type it provides the 
possibility to get info on hard disk geometry, cluster size, exact partition location, etc. 

There are several ways to get properties on a partition/hard disk: 

1. Choose a partition/hard disk on the Disk Map, then select in the Main Menu: Partition/Hard 
Disk > Properties…; 

2. Call the popup menu for the selected partition/hard disk (right click of the mouse button) on 
the Disk Map, then select the menu item: Properties… 
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In the opened dialog information will be grouped according to its properties, thus by clicking tabs 
you can get information you need. 

File Transfer Wizard 
File Transfer Wizard is designed to make such operations as copying of separate files/directories or 
burning of them to CD/DVD as easy and convenient as possible. It may be of particular use in case 
of a system malfunction, caused either by a virus attack or files corruption, in order to get the system 
back on track again. Besides it provides access to Paragon backups as regular folders to browse 
through their contents or copy required files. 

Startup 
There are several ways to start the File Transfer Wizard: 

• Select in the Main Menu: Tools > File Transfer Wizard. 

Setup 
The wizard offers the following steps to accomplish the transfer operation: 

• Place to look for files/directories. Select a source disk from the pull-down list in the left pane of 
the page. The program enables to process both mounted and unmounted (without drive 
letter assigned) partitions. Besides it is possible to map a network drive. 
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• Object(s) of operation. Choose files/directories you want to copy and place them to 
Clipboard by pressing the Add button. To delete a file/directory from the Clipboard, select it in 
the Clipboard pane and press the Remove button. You can also create a new folder, rename 
or irreversibly delete existing files/directories of the left pane by pressing the appropriate 
buttons. 

 

�  
Files/directories deleted from the Clipboard remain intact on source disks. 

• Destination to store the object(s). The File Transfer Wizard allows copying data to local or 
network drives, to physical partitions (without drive letters assigned), or burning them to 
CD/DVDs. Choose the way the data will be stored. 

 

• Revision of changes. The Transfer Summary page provides structurally divided information on 
all the actions made in the wizard. Check the changes and come back to any step of the 
wizard (if necessary) by following the required hyperlink. 
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Result  
After the operation is completed the required data will be placed into the specified destination. 

Available Operation Scenarios: 

• Copying of data from the corrupted system disk to another hard disk 

• Burning of data from the corrupted system disk to CD/DVD 

• Copying of data from a backup to the corrupted system partition 

Mount Partition 
The program enables to assign or remove drive letters of existing formatted partitions. 

Assign Drive Letter 
In order to mount a partition you should take the following steps: 

1. Select a partition on the Disk Map.  

2. Call the Add Drive Letter dialog to set up the operation. There are several ways to do it: 

- Select in the Main Menu: Partition > Assign Drive Letter… 

- Call the popup menu for the selected partition (right click of the mouse button) on the Disk 
Map, then select the menu item: Assign Drive Letter… 

3. Specify a drive letter for the selected partition. Initially the program suggests some consistent 
value for this parameter. So you may just press the Yes button to confirm the operation. 

 

However you can manually define the required letter by selecting it from the pull-down list of 
available drive letters.  

4. The operation will be performed immediately after confirmation. 

Remove Drive Letter 
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In order to un-mount a partition you should take the following steps: 

1. Select a partition on the Disk Map.  

2. Call the Remove Drive Letter dialog to define appropriate settings. There are several ways to 
do it: 

- Select in the Main Menu: Partition > Remove Drive Letter. 

- Call the popup menu for the selected partition (right click of the mouse button) on the Disk 
Map, then select the menu item: Remove Drive Letter. 

3. The operation will be performed immediately after confirmation. 

�  

Modifying drive letter of the system partition will result in inability to boot the 
operating system. 

After having processed partitions with installed software, some programs may 
not run properly. 

Change SID 
SID - Security Identifier is a binary structure that is associated with some object in the system and is 
used to distinguish between user access privileges in workgroup local networks. By default, the SID 
Changer searches Windows installations and then changes SIDs in the found Windows instances to 
automatically generated random SID values. 

To change SID of the desired Windows installation you should take the following steps: 

1. Select a hard disk/partition on the Disk Map. 

2. Call the Change SID dialog to set up the operation. There are several ways to do it: 

- Select in the Main Menu: Partition/Hard Disk > Modify > Change SID… 

- Call the popup menu for the selected partition/hard disk (right click of the mouse button) 
on the Disk Map, then select the menu item: Change SID… 
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3. By default, the utility searches for a BOOT.INI file to extract information on a Windows 
installation and then performs modifying of the found SID by an automatically generated 
random value. However you can manually set a directory to search for a Windows installation. 

�  
The SID changer utility can be applied only to NT and Win2k installations. 

Test Surface 
The program enables to test surface of existing partitions and blocks of free space for bad or 
unstable sectors. If found any it automatically marks them unusable in the file system metadata, thus 
minimizing the risk of data loss. 

In order to start the surface test you should take the following steps: 

1. Select a partition or a block of free space on the Disk Map. 

2. Call the Test Surface dialog to set up the operation. There are several ways to do it: 

- Select in the Main Menu: Partition > Test Surface… 

- Call the popup menu for the selected partition (right click of the mouse button) on the Disk 
Map, then select the menu item: Test Surface… 

3. From the pull-down list choose the level of the surface check. 

 

4. The operation will be performed immediately after confirmation. 

Check File System Integrity 
The program allows you to check integrity of a file system. It can be used to detect possible file 
system errors before performing any operation on a partition. 

To start the system integrity check you should take the following steps: 

1. Select a partition on the Disk Map 

2. Call the Check File System Integrity dialog to set up the operation. There are several ways to 
do it: 

- Select in the Main Menu: Partition > Check File System Integrity 

- Call the popup menu for the selected partition (right click of the mouse button) on the Disk 
Map, then select the menu item: Check File System Integrity. 
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3. Initially the program suggests some consistent values for all parameters. In most cases, you can 
just press the Yes button to confirm the operation. 

 

• Scan for and attempt to recover bad sectors. Mark the checkbox to additionally 
process sectors marked bad in the file system metadata for the purpose of their 
possible recovery. 

4. The operation will be performed immediately after confirmation. 

Check Recovery Discs 
You’ve got the ability to check whether backup media created with the program is 100 percent 
error-free and ready to use. The Check Recovery Disc Wizard will help you do that. 

Startup 
There are several ways to start the Check Recovery Disc Wizard: 

• In the Main Menu: select Tools > Check Recovery Discs… 

Startup 
The wizard offers the following steps to accomplish the operation: 

• CD/DVD drive. Select from the pull-down list of available CD/DVD devices the required drive 
to use during the operation. 

 

• Set whether to eject the disk after the operation is completed or not. 

Result 
After the operation is completed you can see results of the check. 

Send Log Files 
The program enables to simplify the procedure of sending support requests to the Paragon Support 
Team. In case of having difficulties with handling the program, you, with the help of this very function, 
can address the company support engineers and provide them with all the information they need 
such as the disk layout, performed operations, etc. in order to tackle the encountered problem. 
Information of that kind is stored in Log files. 

In order to send log files to the Paragon Support Team you should take the following steps: 
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1. Call the Send Log Files dialog in the Main Menu: Tools > Send Log Files; 

2. Provide a customer name and a product serial number; 

3. Give a detailed description on the encountered problem. 

 

By clicking the Send button the built-in mail client will generate a template request with attached 
compressed log files and then send it to the Paragon Support Team. 

Log Files 
Log files are simple textual files that can be opened by any text editor. There are several log files 
automatically generated by the program: 

Stubact.log  Contains in‐depth information on parameters and performance of all 
operations carried out by the program 

Pwlog.txt�  Besides brief overview on operations it also contains detailed 
information about the state of all hard disks� 

Cdb.log  Contains low-level information on the CD/DVD devices used in the 
system 

BioNTlog.txt 
or Bio95log.txt 

It is an OS-dependent supplementary log file derived from Bioxx.dll. It 
may contain valuable information on Windows family operating 
systems 

 

�  

Log files do not contain any confidential information on the operating system 
settings or the user documents. 

The Send Log Files function is only available when outgoing mail server (SMTP) 
and the user e-mail address are properly set. To learn more about it please 
consult the Settings Overview chapter. 

View Logs 
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With a handy dialog you can study logs on any operation carried by the program. To make this job 
as easy as possible, all the information is structurally divided, besides there is the possibility to see the 
disk layout before and after an operation, what is very convenient.  

In order to view logs on carried out operations call the View Logs dialog in the Main Menu: Tools > 
View Logs… 

 

Typical Scenarios 
This chapter lists a number of the most frequently used scenarios that may be accomplished with the 
program. You can find here useful recommendations and descriptions of operations. 

Backup Scenarios 

Backing up a hard disk or partition to a network drive 
To back up an entire hard disk or a separate partition and then place the resulted image to a 
network share, please do the following: 

1. Launch the Simple Backup Wizard. 
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2. On the Wizard's Welcome page, click the Next button. 

3. On the What to back up page, mark the appropriate option opposite a hard disk’s name or a 
partition’s name depending on the chosen task. 

 

�  
By default the program will take into account exclude filters set in the Settings 
dialog. 

 

4. Map a network disk to place your backup image to: 

- Call the Map Network Drive dialog by clicking the appropriate button; 
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- Click the standard browse button [...] to browse for the required network share or manually 
enter a path to it; 

- Define a  letter from the pull-down list of available drive letters; 

- Mark the checkbox to make this connection permanent. Otherwise it will only be available 
for the current Windows session; 

- Click the Connect as user button at the foot of the dialog page to specify a user name 
and password to access the selected network share if necessary. 

5. Edit the archive name if necessary. 

 

�  

Please take into account values of the parameters Estimated archive size and 
Space available on backup destination - if the archive size exceeds the 
available space, another network drive needs to be selected. 

 

6. Click the Next button to start the backup process. 

�  
This operation can also be accomplished with the Linux/DOS or WinPE 
recovery environments. 

Recovery Scenarios 

Fixing MBR after a boot virus attack 
Let’s assume that the MBR (Master Boot Record) of your hard disk has been corrupted as a result of a 
boot virus attack, thus your system fails to boot. 

To fix the MBR of your hard disk, please do the following: 
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1. Insert Paragon Linux/DOS Recovery CD (the BIOS must be enabled to boot the system from 
the CD/DVD device). 

2. Restart the computer. 

3. In the boot menu select Normal Mode to use the Linux recovery environment (more 
preferable) or Safe Mode to use the PTS DOS recovery environment (in case you’ve got 
problems with Linux). Moreover you’ve got the option to boot into the Low-Graphics Safe 
Mode (PTS DOS safe mode) to cope with a serious hardware incompatibility. In this case, only 
the minimal set of drivers will be included, like hard disk, monitor, and keyboard drivers. This 
mode has simple graphics and a simple menu. 

 

�  
By default the Normal Mode will be automatically initiated after a 10 second 
idle period. 

4. In the Linux launch menu select Boot Corrector. You can find it in PTS DOS as well. 

 

5. On the Wizard's Welcome page, select the Correct the Master Boot Record (MBR) option. 
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6. On the next page choose the required hard disk from the pull-down list (if several) and then 
select the Update the MBR executable code option. 

 

7. Confirm the operation. 

 

8. After the operation is completed click the Report button to see a well informative summary 
page. The program also enables to store the resulted report. To do that, just press the Save 
button and choose the exact location in the opened dialog. 

 

9. Click the Finish button to close Boot Corrector. 
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10. Eject the CD. 

11. Reboot the computer. 

Fixing Windows startup ability 
Let’s assume that due to an unknown reason your Windows fails to complete the startup procedure. 
At first everything seems quite OK, you can see the standard startup messages on the screen, but at 
some moment it hangs up. 

To fix your Windows startup ability, please do the following: 

1. Insert Paragon Linux/DOS Recovery CD (the BIOS must be enabled to boot the system from 
the CD/DVD device). 

2. Restart the computer. 

3. In the boot menu select Normal Mode to use the Linux recovery environment (more 
preferable) or Safe Mode to use the PTS DOS recovery environment (in case you’ve got 
problems with Linux). Moreover you’ve got the option to boot into the Low-Graphics Safe 
Mode (PTS DOS safe mode) to cope with a serious hardware incompatibility. In this case, only 
the minimal set of drivers will be included, like hard disk, monitor, and keyboard drivers. This 
mode has simple graphics and a simple menu. 

 

�  
By default the Normal Mode will be automatically initiated after a 10 second 
idle period. 

4. In the Linux launch menu select Boot Corrector. You can find it in PTS DOS as well. 
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5. On the Wizard's Welcome page, select the Search for Windows installations to correct option. 

 

6. On the next page choose the required Windows installation from the list of found installations 
(if several), then select the Edit the Boot.ini file option. If you’re not sure which installation you 
need, please use the Properties button to get more info on the selected item. 

 

7. Examine the file – maybe that’s where the problem is. If it contains a mistake, correct it by 
using the appropriate buttons. 
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8. If the Boot.ini file does not contain any mistake, please return to the Correct Windows 
Installations page to correct drive letters in the Windows System Registry. 

 

9. On the next page choose a hard disk from the pull-down list (if several), then the required 
partition. If you’re not sure which installation you need, please use the Properties button to get 
more info on the selected item. 
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10. Click the Edit Letters button to correct an existing drive letter or assign a new one in the 
Windows System Registry. 

 

11. Once you’ve assigned the appropriate drive letter, close the dialog, then click the Apply 
button. 

12. Confirm the operation. 

 

13. After the operation is completed click the Report button to see a well informative summary 
page. The program also enables to store the resulted report. To do that, just press the Save 
button and choose the exact location in the opened dialog. 
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14. Click the Finish button to close Boot Corrector. 

15. Eject the CD. 

16. Reboot the computer. 

Restoring a system partition from a network drive 
Let’s assume that your computer fails to boot because of a virus attack or corruption of some system 
critical files. But you’ve got a backup of your hard disk on a remote backup server. That’s just enough 
to easily get your system back on track again. 

To restore your system partition from a backup image located on a network drive, please do the 
following: 

1. Insert Paragon WinPE Recovery CD (the BIOS must be enabled to boot the system from the 
CD/DVD device). 

2. Restart the computer. 

3. After the disc has been loaded, read the agreement and then mark the appropriate 
checkbox to accept. 
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�  
If you do not agree with any conditions stated there, you won’t be able to use 
the program. 

4. Once you accept the agreement, you will see the Universal Application Launcher. Select the 
Restore Wizard. 

 

5. On the Restore Wizard's Welcome page, click the Next button. 

6. On the Browse for Archive page you need to specify the required backup image. So you 
should take the following steps to do that: 

• Select Network as a backup destination; 
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• Map a network disk where your archives are placed: 

- Call the Map Network Drive dialog by clicking the appropriate button; 

 

- Click the standard browse button [...] to browse for the required network share or 
manually enter a path to it; 

- Define a letter from the pull-down list of available drive letters; 

- Click the Connect as user button at the foot of the dialog page to specify a user name 
and password to access the selected network share if necessary. 

�  
You can also map a network disk with Network Configurator. 

• Choose the required archive in the browser-like window. The Archive File Details section 
displays a short description of the selected image. 
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7. The What to Restore page displays detailed information about the contents of the archive. 
Select the required item to restore. In our case it is the first partition of the disk. 

 

8. On the Where to Restore page specify a hard disk, then one of its partitions to restore the 
image to (if several in your computer). By default, the program offers to restore the archive 
exactly where it belongs. That’s what we actually need. 

 

�  
All contents on the partition selected for restoring purposes will be deleted 
during the operation. 
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9. On the Restore Results page you can see the resulted disk layout. Besides there’s the possibility 
to change size of the partition and its location if necessary as well as assign a particular drive 
letter. 

 

10. On the next page of the wizard confirm the operation by selecting the appropriate option. 

 

11. In the Progress window you can see in real-time a detailed report on all actions carried out by 
the program. 

 

Mark the checkbox at the bottom of the window to automatically switch off the computer on 
the successful accomplishment of the restore operation. 

12. After completing the operation close the wizard, take out the disc and then reboot the 
computer. 
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�  

This operation can also be accomplished with the Linux/DOS recovery 
environment. 

To make a Win2K+ operating system bootable on different hardware, please 
additionally complete the P2P Adjust OS Wizard. 

Copying of data from the corrupted system disk to another hard disk 
To retrieve valuable information from your hard disk and copy it to another hard disk when the 
system fails to boot, please do the following: 

1. Connect the second hard disk to the computer. 

2. Insert Paragon Linux/DOS Recovery CD (the BIOS must be enabled to boot the system from 
the CD/DVD device). 

3. Restart the computer. 

4. In the boot menu select Normal Mode to use the Linux recovery environment (more 
preferable) or Safe Mode to use the PTS DOS recovery environment (in case you’ve got 
problems with Linux). Moreover you’ve got the option to boot into the Low-Graphics Safe 
Mode (PTS DOS safe mode) to cope with a serious hardware incompatibility. In this case, only 
the minimal set of drivers will be included, like hard disk, monitor, and keyboard drivers. This 
mode has simple graphics and a simple menu. 

 

�  
By default the Normal Mode will be automatically initiated after a 10 second 
idle period. 

5. In the Linux launch menu select the File Transfer Wizard. You can find the same wizard in PTS 
DOS as well. 
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6. On the Wizard's Welcome page, click the Next button. 

7. Select a disk where the files you need are stored from the pull-down list in the right pane of the 
page. 

 

8. Select files you want to copy and place them to Clipboard by pressing the left arrow-button. 
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Click the Calc button to estimate the resulted data size. 

9. On the Select Destination Type, choose the way the data will be stored. Select the Save data 
to any local drive or a network share item. 

 

10. On the Select Destination Path page, select a hard disk to copy the data to by pressing the 
standard browse button [...]. 

 

11. On the Transfer Summary page check all parameters of the operation. Click the Next button 
to accomplish the operation. 

12. In the Progress window you can see in real-time a detailed report on all actions carried out by 
the program. 

 

13. After the operation is completed, close the wizard by pressing the appropriate button. 

14. Eject the CD. 

15. Turn off the computer. 

�  
This operation can also be accomplished with the WinPE recovery 
environment. 
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Burning of data from the corrupted system disk to CD/DVD 
To retrieve valuable information from your hard disk and burn it to CD/DVD when the system fails to 
boot, please do the following: 

1. Insert Paragon Linux/DOS Recovery CD (the BIOS must be enabled to boot the system from 
the CD/DVD device). 

2. Restart the computer. 

3. In the boot menu select Normal Mode to use the Linux recovery environment, since it’s the 
only mode that enables to burn CD/DVD discs. 

 

�  
By default the Normal Mode will be automatically initiated after a 10 second 
idle period. 

4. In the Linux launch menu select the File Transfer Wizard. You can find the same wizard in PTS 
DOS as well. 

 

5. On the Wizard's Welcome page, click the Next button. 

6. Select a disk where the files you need are stored from the pull-down list in the right pane of the 
page. 
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7. Select files you want to copy and place them to Clipboard by pressing the left arrow-button. 

 

Click the Calc button to estimate the resulted data size. 

8. On the Select Destination Type, choose the way the data will be stored. Select the Burn data 
to CD/DVD item. 

 

9. On the Choose a Recorder page, select a recorder from the list of available devices and then 
set a volume label by entering it in the appropriate field. 
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10. On the Transfer Summary page check all parameters of the operation. Click the Next button 
to accomplish the operation. 

11. In the Progress window you can see in real-time a detailed report on all actions carried out by 
the program. 

 

12. After the operation is completed, close the wizard by pressing the appropriate button. 

13. Eject the CD. 

14. Turn off the computer. 

�  
This operation can also be accomplished with the WinPE recovery 
environment. 

Copying of data from a backup to the corrupted system partition 
The system fails to boot since some files are damaged. If you have a backup of the system partition, 
you can recopy these files to make the system be operable again: 

1. Insert Paragon Linux/DOS Recovery CD (the BIOS must be enabled to boot the system from 
the CD/DVD device). 

2. Restart the computer. 

3. In the boot menu select Normal Mode to use the Linux recovery environment (more 
preferable) or Safe Mode to use the PTS DOS recovery environment (in case you’ve got 
problems with Linux). Moreover you’ve got the option to boot into the Low-Graphics Safe 
Mode (PTS DOS safe mode) to cope with a serious hardware incompatibility. In this case, only 
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the minimal set of drivers will be included, like hard disk, monitor, and keyboard drivers. This 
mode has simple graphics and a simple menu. 

 

�  
By default the Normal Mode will be automatically initiated after a 10 second 
idle period. 

4. In the Linux launch menu select the File Transfer Wizard. You can find the same wizard in PTS 
DOS as well. 

 

5. On the Wizard's Welcome page, click the Next button. 

6. Select a disk where the system backup is stored from the pull-down list in the right pane of the 
page. 
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7. Double click on the required backup to open. 

 

8. Select files you want to copy and place them to Clipboard by pressing the left arrow-button. 

 

Click the Calc button to estimate the resulted data size. 

9. On the Select Destination Type, choose the way the data will be stored. Select the Save data 
to any local drive or a network share item. 
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10. On the Select Destination Path page, select your system disk to copy the data to by pressing 
the standard browse button [...]. 

 

11. On the Transfer Summary page check all parameters of the operation. Click the Next button 
to accomplish the operation. 

12. In the Progress window you can see in real-time a detailed report on all actions carried out by 
the program. 

 

13. After the operation is completed, close the wizard by pressing the appropriate button. 



108 

Copyright© 1994-2010 Paragon Software Group. All rights reserved. 

14. Eject the CD. 

15. Turn off the computer. 

�  
This operation can also be accomplished with the WinPE recovery 
environment. 

Cloning System Hard Disk 
To migrate your system hard disk to a larger disk, please do the following: 

1. Connect both source and destination disks to the computer. 

2. Turn on the computer. 

3. Launch the Copy Hard Disk Wizard. 

 

4. On the Wizard's Welcome page, click the Next button. 

5. On the Select Hard Disk to Copy page, select a source disk (a hard disk you want to copy). 

 

6. On the Select Target Hard Disk page, select a destination disk (a hard disk to copy contents of 
the source disk). 
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�  
During the operation all contents of the destination disk will be deleted. 

7. On the next page of the wizard, define the copy options. In our case we’d rather copy data 
with a proportional resize to occupy the entire disk. 

 

8. On the Revise Copy Results page review all parameters of the operation. 

 

9. Complete the wizard. 

10. When copying is completed, shut down the computer. 

11. Disconnect (physically) the source hard disk. 

12. Boot the computer from the destination hard disk. 
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�  

This operation can also be accomplished with the Linux/DOS or WinPE 
recovery environments. 

To make a Win2K+ operating system bootable on different hardware, please 
additionally complete the P2P Adjust OS Wizard. 

P2V Scenarios 

Virtualizing the current system 
Let’s assume that you’re about to migrate to a brand-new hardware platform with the latest 
operating system available for it. Your current system is quite obsolete, but you still need access to 
some of its software. You don’t want to waste time re-installing the old software to the new system, 
and you do know for sure that the bulk of it won’t work anyway. The best way out is to virtualize your 
old system. 

To make a virtual disk out of your current system, please do the following: 

1. Launch the P2V Copy Wizard. 

 

2. On the Wizard's Welcome page, click the Next button. 

3. Select either an entire hard disk or only the system partition you want to make a virtual disk of. 

 

4. Choose your virtualization software vendor and a number of additional parameters, including. 

• Type of the virtual disk. You can either create an IDE or a SCSI virtual disk (relevant for 
VMware only); 
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• Create a split disk. You can choose whether to automatically cut the resulted virtual 
image to files of 2 GBs or not (available for VMware only); 

• Pre-allocate all disk space. You can choose whether to pre-allocate all space of the 
future virtual disk, or do it dynamically; 

 

�  

Not all vendors may be available to choose. If the capacity of the selected 
object exceeds the maximum capacity for a certain virtual disk, its vendor will 
be shadowed. 

 

5. Depending on your choice the next page of the wizard enables to set the following 
parameters: 

For a separate partition 

• Size of the virtual disk. By default the program offers to create a virtual disk exactly the 
size of the selected object, which you can upsize however. Please note, you can only 
increase size of the resulted virtual disk; 

• Take all space for the partition. If you upsize the resulted virtual disk, you can choose 
whether to occupy the whole disk space by that partition or not; 

• Adjust OS to virtual hardware to make sure the operating system will be bootable after 
the operation. 
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For a hard disk 

• Size of the virtual disk. By default the program offers to create a virtual disk exactly the 
size of the selected object, which you can resize however. 

• Resize partitions proportionally. If you upsize the resulted virtual disk, you can make the 
program proportionally change the size of partitions keeping their relative order intact. 

• Adjust OS to virtual hardware to make sure the operating system will be bootable after 
the operation. 

 

�  
The maximum limit you can downsize the virtual disk is the capacity of its first 
partition. 

 

6. On the next page of the wizard set a file name for the resulted virtual disk and its location. 
Besides you can also provide a path to the integration package of your virtualization software. 

 

�  
It’s strongly recommended to provide a path to VM Tools/Additions ISO image 
if you transfer Windows XP to a VMware SCSI disk, otherwise your system won’t 
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boot after the operation. 

 

7. The wizard will provide a detailed report on successful accomplishment of the operation. You 
can save it by clicking the appropriate button. 

 

Now you can connect the resulted virtual disk to your virtual machine. Your system has been 
virtualized. 

Connecting virtual disks 
With our program you can only create virtual disks not virtual machines. Thus to work with your 
virtualized system, first you need to connect its virtual disk to a virtual machine. Actually you’ve got 
two options: 

• Connect the virtual disk to an existing virtual machine; 

• Connect the virtual disk to a new virtual machine. 

Below you can see how to accomplish these operations with VMware Workstation. If you’ve got to 
do with another virtual machine, the work algorithm will be very much alike. Anyway, to know more 
on the subject, please consult documentation that comes with your virtual software. 

Connecting virtual disks to an existing virtual machine 
To connect a VMware Workstation virtual disk to an existing virtual machine, please do the following: 

1. Open an existing VMware Workstation virtual machine. 
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2. Please make sure its guest OS is the same as on your virtual disk, otherwise you may face 
hardware incompatibility problems. 

 

3. Click Add… to connect your virtual disk to the machine. 



115 

Copyright© 1994-2010 Paragon Software Group. All rights reserved. 

 

4. In the opened dialog select Hard Disk as the required hardware type to add. 

 

5. On the next page select Use an existing virtual disk. 

 

6. Browse for your virtual disk. 
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7. Click Finish to complete the operation. Most likely you will be asked to convert your virtual disk 
to a new format. You can update your disks, since this procedure involves change of a version 
only, nothing else. To know more on the subject please consult the Known Issues chapter. 

 

8. That’s all. You can now launch the virtual machine. 

 

Connecting virtual disks to a new virtual machine 
To connect a VMware Workstation virtual disk to a new virtual machine, please do the following: 

1. Click New Virtual Machine. 
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2. On the Wizard's Welcome page, click the Next button. 

3. On the next page select Typical. 

 

4. Select the required guest OS. Please make sure it’s the same as on your virtual disk, otherwise 
you may face hardware incompatibility problems. 

 

5. Provide a name and location for your virtual machine. 
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6. Select a network connection type. To know more on the subject, please consult 
documentation that comes with your virtual software. 

 

7. As the final step the wizard will offer you to create a virtual disk. As you cannot skip it, click 
Finish to complete the operation. 

 

8. Edit settings of the newly created machine. 
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9. Select the default virtual disk and click Remove to delete. 

 

10. Click Add… to connect your virtual disk to the machine. 

 

11. In the opened dialog select Hard Disk as the required hardware type to add. 
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12. On the next page select Use an existing virtual disk. 

 

13. Browse for your virtual disk. 

 

14. Click Finish to complete the operation. Most likely you will be asked to convert your virtual disk 
to a new format. You can update your disks, since this procedure involves change of a version 
only, nothing else. To know more on the subject please consult the Known Issues chapter. 

 

15. That’s all. You can now launch the virtual machine. 



121 

Copyright© 1994-2010 Paragon Software Group. All rights reserved. 

 

P2P Scenarios 

Making system bootable on different hardware 
Let’s assume you had to migrate to a new hardware platform. You just connected your system hard 
disk to the brand new PC and tried to start up the operating system - you do know for sure now that 
this operation had been doomed to failure from the very beginning. With our program you can easily 
tackle this naughty problem. 

To recover bootability after migrating your physical system to different hardware, please do the 
following: 

1. Insert WinPE CD (the BIOS must be enabled to boot the system from the CD/DVD device). 

2. Restart the computer. 

3. After the disc has been loaded, read the agreement and then mark the appropriate 
checkbox to accept. 
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�  
If you do not agree with any conditions stated there, you won’t be able to use 
the program. 

 

4. Once you accept the agreement, you will see the Universal Application Launcher. Launch the 
P2P Adjust OS Wizard. 

 

�  

Our WinPE 2.1 based CD offers excellent hardware support. However in case it 
doesn’t have a driver for your disk controller, your hard disks will be 
unavailable. Please consult the Adding specific drivers scenario to know how 
to tackle this issue. 
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5. On the Wizard's Welcome page, click the Next button. 

6. From the list of all found Windows based operating systems (if several) select one you need to 
adjust to your new hardware. If you’re willing to adjust them all, just re-launch this wizard for 
each. 

 

�  
The wizard can only work with Microsoft Windows 2000 and later operating 
systems. 

 

7. Choose whether you’re going to add drivers for the new hardware to the selected operating 
system or not and the way it’s to be done. Actually you’ve got three options: 

• Upload drivers automatically from the provided driver repository. Generally together with 
new hardware you get its drivers for different operating systems on removable media 
(mostly CD or DVD). By collecting all these drivers in one folder you can let the wizard 
automatically pick and install only those required for your OS (recommended); 

• Upload drivers manually. If you know exactly what drivers your operating system is lacking 
to successfully start up, you can manually provide them for the wizard. 

• Do not upload drivers. And finally you can just refuse providing 3rd party drivers. 

 

We prefer the wizard to decide what drivers are to be installed. 
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8. Browse for a folder with drivers for the new hardware or type in a full path to it manually.  

 

9. Apply the changes by confirming the operation. 

 

After the operation is completed your system will be bootable on the new hardware. 

Extra Scenarios for WinPE CD 

Adding specific drivers 
Our WinPE 2.1 based CD offers excellent hardware support. Anyway you’ve got the option to add 
drivers for specific hardware with a handy dialog. 

To add drivers for specific hardware, please do the following: 

1. Once you accept the agreement, you will see the Universal Application Launcher. Click Add 
Drivers. 

 

2. In the opened dialog browse for an .INF file of the required driver package located on a 
floppy disk, local disk, CD/DVD or a network share. Then click the Open button to initiate the 
operation 
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�  
To know how to map a network share, please consult the Configuring network 
scenario. 

 

3. You will be notified on the successful accomplishment of the operation. Click Yes to load 
another driver or No to close the dialog. 

 

�  
Our WinPE 2.1 recovery environment is 32-based, thus you need to use 32-bit 
drivers for injection. 

Configuring network 
If your local network has a DHCP server, a network connection will be automatically configured once 
our WinPE CD has been started up. Otherwise you will need to do it manually with a handy dialog by 
providing an IP address, a network mask, default gateway, etc. Besides with its help you can easily 
map network shares.   

To manually set up a network connection and map a network share, please do the following: 

1. Once you accept the agreement, you will see the Universal Application Launcher. Click 
Configure Network. 
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2. In the opened dialog provide an IP address, a network mask, default gateway, etc. for your 
network device. 

 

3. Click the Network drivers tab to map a network share. 

 

4. Click Map Network Drive and provide all the necessary information to map a network share in 
the opened dialog:  
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• Click the standard browse button [...] to browse for the required network share or manually 
enter a path to it; 

• Define a letter from the pull-down list of available drive letters; 

• Click the Connect as user button at the foot of the dialog page to specify a user name 
and password to access the selected network share if necessary. 

By clicking Disconnect Drive… you can delete an existing network share if necessary. 

5. Click the Network identification tab to change a network name of your computer (generated 
automatically) and a workgroup name. 

 

6. By default, the wizard saves all network settings in the netconf.ini file located on the WinPE 
RAM drive, thus it will only be available until you restart the computer. However, you can just 
once configure your network device and then save this file to some other destination, for 
instance a local drive, and this way avoid constant re-configuration, just by providing a path 
to it. So Click Save to file to save the netconfig.ini file to the required destination. 

Saving log files 
The program enables to simplify the procedure of sending support requests to the Paragon Support 
Team. In case of having difficulties with handling the program, you, with the help of this very function, 
can address the company support engineers and provide them with all the information they need 
such as the disk layout, performed operations, etc. in order to tackle the encountered problem. 
Information of that kind is stored in log files. 

To prepare a log files package, please do the following: 

1. Once you accept the agreement, you will see the Universal Application Launcher. Click Log 
Saver. 
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2. In the opened dialog browse for the required location of the log files package or manually 
provide a full path to it. Click Collect to initiate the operation. 

 

�  
Log files do not contain any confidential information on the operating system 
settings or the user documents. 

Troubleshooter 
Here you can find answers to the most frequently asked questions that might arise while using the 
program. 

1. I try to run an operation, but the program claims my partition is in use and suggests restarting 
the computer. 

There are a number of operations that cannot be performed while your partition is in use (or 
locked in other words). Please agree to reboot your machine to make the program 
accomplish the operation in a special boot-up mode. 

2. I run an operation and restart the machine as required, but it just boots back into Windows 
without accomplishing the operation. 

Please run 'chkdsk /f' for the partition in question. 

3. I cannot create a new partition on the disk. 

There can be a number of reasons for that: 
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• The program cannot create a new partition on a dynamic disk, but only on a hard disk 
that uses the DOS partitioning scheme. 

• According to the rules of the DOS partitioning scheme, the following combinations of 
partitions cannot be created: 

- Two Extended Partitions on one hard disk; 

- Five or more Primary partitions on one hard disk; 

- If there is an Extended Partition on the disk, only three Primary partitions are allowed. 

• The program allows creating new partitions only within blocks of un-partitioned space. It 
cannot convert a free space on an existing partition to a new partition. 

4. I cannot copy a partition. 

There can be a number of reasons for that: 

- The source or target disk you select is a dynamic disk; 

- 4 primary partitions (or three primary partitions and an extended one) already exist on the 
target disk. 

5. I need to copy a partition. But when selecting a place where to make a copy, I always get a 
crossed circle sign no matter which partition is selected. 

The program enables to copy a partition only to a block of un-partitioned space. If you don’t 
have a block of free space on your hard disk, please delete or reduce an existing partition to 
accomplish the operation. 

6. I cannot do anything with my USB flash drive. I get a crossed circle sign when trying to select 
any area on it. 

Some USB flash drives don't have the MBR (Master Boot Record), that’s the cause of your 
problem. To fix the issue please use the Update MBR function of our program or 'fixmbr' of the 
Windows installation disc to write a standard code to your flash drive. 

7. When trying to back up my system the program asks to restart the computer. 

Most likely the Hot Processing mode is disabled. Please make it active in the program settings. 

8. When backing up a partition with the VSS (Volume Shadow Copy Service) mode, the program 
throws "VSS could not be started for processed volume". 

Most likely you try to back up a FAT32 partition, which is not supported by VSS. Please use the 
Paragon Hot Processing mode instead. 

9. I cannot back up my hard disk to an external hard drive. Once started, the operation is 
aborted with the following error: Hard Disk management, Error Code 0x1100a. What is wrong 
here? 
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The problem is that the Microsoft VSS service is set as the default Hot Processing mode in the 
program. But this service has not been started in your WindowsXP/Windows2003/Vista. Please 
start this service (right click on My Computer > Manage > Services > find Microsoft Volume 
Shadow Copy Service and make it active. Set also to start it automatically). 

10. When running a backup operation with the Paragon Hot Processing mode enabled, I get an 
error: error code 0x1200e "Internal error during Hot Backup" 

Most likely your hard disk contains bad blocks. Please fix the issue with your HDD 
manufacturer's tool. 

You can find a name of the tool you need here: http://kb.paragon-software.com 

11. When running a backup operation with the Microsoft VSS mode enabled, I get the following 
error: error code 0x12016 "VSS: can't read volume data” 

Most likely your hard disk contains bad blocks. Please fix the issue with your HDD 
manufacturer's tool. 

You can find a name of the tool you need here: http://kb.paragon-software.com 

12. When trying to back up to a network share, I get the following error: "i/o error" or "can't 
open/create file" 

Please check whether you’ve got a permission to write to the selected destination or not. 

13. When trying to restore a backup archive, I get the following error: "Can't restore to current 
selection" or "Archive does not fit" 

Most likely you’re trying to restore a backup of the whole hard disk to a partition or vice versa. 

14. I set up a timetable for a task, but it fails to execute. 

There can be a number of reasons for that: 

- Windows Task Scheduler does not work properly. Check whether it is so or not by scheduling 
a simple task (call Notepad through scheduling); 

- You don’t have permission to write to the selected backup destination. 

Glossary  
Active Partition is a partition from which an x86-based computer starts up. The active partition must 
be a primary partition on a basic disk. If you use Windows exclusively, the active partition can be the 
same as the system volume.  

In the DOS partitioning scheme, only primary partitions can be active due to limitations of the 
standard bootstrap. 

The term backup originates from the time when the best way to protect valuable information was to 
store it in form of archives on external media. It’s become now a general notion to mean making 
duplications of data for protection purposes. 
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Bootable Archive is created by adding a special bootable section when backing up the data to 
CD/DVDs. Thus you will be able to restore the data from these archives without having to run the 
program, but by simply booting from these CD/DVDs. 

Cluster is the smallest amount of disk space that can be allocated to hold a file. All file systems used 
by Windows organize hard disks based on clusters, which consist of one or more contiguous sectors. 
The smaller the cluster size, the more efficiently a disk stores information. If no cluster size is specified 
during formatting, Windows picks defaults based on the size of the volume. These defaults are 
selected to reduce the amount of space that is lost and the amount of fragmentation on the 
volume. A cluster is also called an allocation unit. 

Extended Partition is a partition type you create only on a basic MBR (Master Boot Record) disk. 
Extended partition is used if you want to create more than four volumes on a disk, since it may 
contain multiple logical drives. 

File System Metadata. The servicing structures of a file system, which contain information about 
allocating files and directories, security information etc, are named the file system metadata. It is 
invisible for users and regular applications because its accidental modification usually makes a 
partition unusable. 

Hard Disk Geometry. Traditionally, the usable space of a hard disk is logically divided into cylinders, 
cylinders are divided into tracks (or heads), and tracks are divided into sectors. 

The triad of values {[Sectors-per-Track], [Tracks-per-Cylinder], [Amount-of-Cylinders]} is usually named 
the Hard Disk Geometry or C/H/S geometry. 

Tracks and cylinders are enumerated from "0", while sectors are enumerated from "1". These disk 
parameters play an essential role in the DOS Partitioning scheme. 

Modern hardware uses an advanced scheme for the linear addressing of sectors, which assumes 
that all on-disk sectors are continuously enumerated from “0”. To allow backward compatibility with 
older standards, modern hard disks can additionally emulate the C/H/S geometry. 

Hidden Partition. The concept of a "hidden" partition was introduced in the IBM OS/2 Boot Manager. 
By default, an operating system does not mount a hidden partition, thus preventing access to its 
contents. 

A method of hiding a partition consists in changing the partition ID value saved in the Partition Table. 
This is achieved by XOR-ing the partition ID with a 0x10 hexadecimal value. 

Master File Table (MFT) is a relational database that consists of rows of file records and columns of file 
attributes. It contains at least one entry for every file on an NTFS volume, including the MFT itself. MFT is 
similar to a FAT table in a FAT file system. 

MBR & 1st track of the hard disk is the 0th sector of the disk. MBR (Master Boot Record) contains 
important information about the disk layout: 

- The used partitioning scheme; 

- The starting records of the Partition Table; 



132 

Copyright© 1994-2010 Paragon Software Group. All rights reserved. 

- The standard bootstrap code (or the initial code of boot managers, disk overlay software or boot 
viruses). 

Generally, the 0th sector is used for similar purposes in all existing partitioning schemes.  

The MBR capacity is not sufficient to contain sophisticated boot programs. That’s why the on-boot 
software is allowed to use the entire 0th track of the disk. For example, boot managing utilities such 
as LILO, GRUB and Paragon Boot Manager are located in the 0th track. 

Partition ID (or File system ID) is a file system identifier that is placed in the partition. It is used to quickly 
detect partitions of supported types. A number of operating systems completely rely on it to 
distinguish supported partitions. 

Partition ID is saved in appropriate entries of the Partition Table and takes only 1 byte of space. 

Partition Label (or Volume Label) is a small textual field (up to 11 characters) that is located in the 
partition's boot sector. This value is used for notification purposes only. It is detectable by any 
partitioning tool including the DOS FDISK utility. 

Modern operating systems save it within a file system, e.g. as a special hidden file. Thus it is able to 
contain a relatively large amount of text in multiple languages. 

Partitioning Scheme is a set of rules, constraints and format of the on-disk structures to keep 
information on partitions located on a hard disk. 

There are known several partitioning schemes. The most popular of them is the so-called DOS 
partitioning scheme. It was introduced by IBM and Microsoft to use multiple partitions in the disk 
subsystems on IBM PC compatible computers. 

Another popular partitioning scheme is the so-called Logical Disks Model (LDM) that originates from 
the UNIX mainframe systems. Veritas Executive accommodates a simplified version of LDM to the 
Windows 2000 operating system. 

Windows 2000 and XP support two quite different partitioning schemes: the old DOS partitioning 
scheme and the new Dynamic Disk Management (DDM). The problem is that earlier versions of 
Windows do not support DDM. In addition, most hard disk utilities do not support it as well. 

Recovery Media is a CD/DVD disc, a USB flash card or even a floppy disk from which you can boot 
for maintenance or recovery purposes. 

Root Directory is the top-level directory of a formatted logical drive to include other files and 
directories. In modern file systems (Ext2/Ext3, NTFS and even FAT32) it does not differ from other 
directories. This is not the case for old FAT12 and FAT16 file systems. 

Serial Number. In the DOS partitioning scheme, every hard disk and every partition has a 32-bit serial 
number represented by an 8-figure hexadecimal value. It is stored in the MBR and its value is 
assigned when the MBR sector is initialized by Microsoft standard disk managing tools, such as 
Windows Disk Administrator and the FDISK utility. 

In fact, a hard disk's serial number is not important for most operating systems and software. It is 
known that Windows NT, 2000 and XP store its value in the database of assigned drive letters. 
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A partition's serial number is stored in its boot sector (in FAT16, FAT32 and NFTS file systems). Its value is 
assigned when the partition is formatted. It does not play an important role for most operating 
systems and software as well. 


